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Instruction sheet
This learning guide is developed to provide you the necessary information regarding the

following content coverage and topics:

 Determining specifications for embroidery design.

 Identifying available software programs.

 Identifying garment considerations.

 Identifying machine requirements.

This guide will also assist you to attain the learning outcome stated in the cover page.
Specifically, upon completion of this Learning Guide, you will be able to:

 Determine specifications for embroidery design.

 Demonstrate available software programs.

 Apply garment considerations.

 Identify machine requirements.
Learning Instructions:

Read the specific objectives of this Learning Guide.

1. Follow the instructions described below.

2. Read the information written in the “Information Sheets”. Try to understand what are being

discussed. Ask your trainer for assistance if you have hard time understanding them

3. .Accomplish the “Self-checks” which are placed following all information sheets.

4. Ask from your trainer the key to correction (key answers) or you can request your trainer to

correct your work. (You are to get the key answer only after you finished answering the

Self-checks).

5. If you earned a satisfactory evaluation proceed to “Operation sheets

6. Perform “the Learning activity performance test” which is placed following “Operation

sheets” ,

7. If your performance is satisfactory proceed to the next learning guide,

8. If your performance is unsatisfactory, see your trainer for further instructions or go back to

“Operation sheets”.

LG #27 LO #1- Create original design
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Information Sheet-1
1.1.Determining specifications for embroidery design

Introduction

Embroidery is the craft of decorating fabric or other materials using a needle to

apply thread or yarn. Embroidery may also incorporate other materials such as

pearls, beads, quills, and sequins. Embroidery is usually seen on caps, hats, coats,

blankets, dress shirts, denim, dresses and golf shirts. Embroidery is available with

a wide variety of thread or yarn color.

1.1.1.Content

Embroidry designs contain diffirent design in combination or images with text according

to the purpose or requirement of the design

1.1.2.Color
Choose your embroidery thread colors,First you can use multiple shades of one color to

create a monochromatic color scheme. Each color in this scheme is a different shade, or

hue of pink. Because all of those hues would be in the same section of the color.Change

thread colors of the design directly on screen.Colour coordination is more important in

embroidery than anywhere else. Contrasting colours, monotones, shades of the same

colour, an ombre effect – all are popular. But colors are mostly personal. What appeals to

you may not appeal to me. What is popular in one society may not be used in another.

You should know that colour value of a colour changes when they are placed with other

colours – so keep the fabric and the colours you are going to use with the embroidery

together and decide on the colour scheme you are going to choose for the embroidery

project.
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Fig.1.1.different colors

1.1.3.Dimensions
Put your embroidery design in the client specification place and dimension.

 See the following figure.

Fig. 1.2 show dimension

1.1.4.Stitch type and size

 Fill Stitches

 Satin stitch

 Running stitch
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Fig1.3.stitch type

An embroidery stitch, “is defined as the movement of the embroidery needle from

the backside of the fabric to the front side and back to the back side.

The thread stroke on the front side produced by this is also called stitch. In the

context of embroidery, an embroidery stitch means one or more stitches that are

always executed in the same way, forming a figure of recognisable look.

Embroidery stitches are also called stitches for short. Embroidery stitches are the

smallest units in embroidery. Embroidery patterns are formed by doing many

embroidery stitches, either all the same or different ones, either following a

counting chart on paper, following a design painted on the fabric or even working

freehand”. This basic principle also applies to machine embroidery.

There are three basic types of stitches that can be used to create embroidery

design/ shapes:

 Fill Stitches – Useful for filling in wide areas with color, wider than 10mm (.4

inches) – areas too wide to be filled in with satin stitches. Sit flatter and don’t have

the same sheen as satin stitches.

Multiple lines of walking stitches that fill an entire area; blocks of coloured areas
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The fill stitch is also used to create an underlay foundation to layer more

complicated embroidery designs or designs being sewn on flimsy materials (rayon,

silk, etc). On high pile garments such as fleece, a fill stitch may be used to create

a foundation so an acceptable amount of detail is not lost in the fabric fibers.

Fill stitches are used to cover large areas in a design. They have a flat look and

less sheen than a satin stitch, but they can fill an area much larger than is easily

achieved by the limits of the satin stitch and avoid the rippled texture that areas

filled with overlapped satins will tend to have.

 Satin Stitches/Column Stitch – Excellent for narrow detail like lettering

stems, vinework, borders. But can be no wider than 0.4 inches (10mm) and no

narrower than 1mm (0.04 inches).

Satin stitches track back and forth over a narrow area, alternating between an

angled stitch and a straight stitch, like a zig-zag with every other stitch

perpendicular to the area’s edges. The satin stitch has a shiny finish due to the

unbroken, long threads in those straight passes.

This is the most common embroidery stitch type and is used in the majority of

lettering and design outlines.

 Running or Walking Stitch- A single, straight stitch that provides detail.

Used for outlining small items and widths less than 1 mm or simply to walk from

one part of the design to the other. used for drawing fine detail. .

The dashed line style is typically used to capture very small details in embroidery

designs. The walking stitch is commonly used to re-create the look of hand sewing

in many retail designs.

Different stitch techniques are used for specific purposes when embroidering a

design or logo. Depending on the look of the design and the fabric being

embroidered. There are three main types of stitches you need to consider in

computerised embroidery:
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Sizing

Objects may be sized to any desired measurement. It is important to note,

however, that while you may customize images to any desired size, the quality of

cuts made may vary, especially when cutting thicker materials such as cardstock.

Reducing the size of an image with intricate parts and cutting it in a thicker

material is an example where the cut quality could suffer

1.1.5.Font

Find more than 100 fonts for embroidery machines.

Letters are individual stitch files and therefore you must have embroidery editing

software to merge your letters together to form words, names and monograms.

Find the font you like best, from fonts set in movies, series and all kinds of

productions. We also have original and fun fonts created by professional

designers.

Fig1.4.design fonts

Understanding why some fonts look good and why others lack quality and

appearance can contribute to a few factors.
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1.1.6.Fill

Pattern Fill A pattern fill area is an area of stitching where the threads all lie
parallel to each other, and that has stitch points inserted to create different types
of patterns. The density and color can also be changed with single gradient
density and multigradient density.

Fig.1.5.fill stitch

Pattern Fill Area,

The patterns may be simple textures or decorative shapes. A satin-effect pattern
(pattern number 36 in Standard 3) is also available. Constant density creates a
uniform fill at the chosen density. Gradient density creates a fill with varying
density or color. Use the Pattern Fill properties dialog box (if available) to change
the pattern, density and stitch angle used for fill areas.

Satin Column

Satin Column forms a column of straight or curving satin. Use the Satin Column
Options to set density, compensation, pattern (for columns wider than around
8-10mm) and underlay.
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Tatami. The typical fill stitch for filling large and irregular shapes. Made of rows of
run stitches

Satin. To fill narrow shapes. Can be used with auto-split for filling larger areas

Motif. A kind of repetitive drawing. Patterns are repeated in rows to create
decorative fills

Curved fills: Follow the contour of a shape and can create some kind of curved
light/shade 3D drawing effect

Contour: Similar as a fill or emboss patterns but follows the curve of the object.

generating embroidery stitch patterns in a computer aided design system where

areas defined by vector outline shapes are filled with stitches which follow curved

lines rather than straight lines.

this is done in a way to maintain consistent densities and consistent needle

penetration patterns inside the areas. The shapes of the areas may be simple

polygons which can be filled in one contiguous segment of curved stitching, or

they may be complex or multi-boundary shapes which must be stitched in more

than one distinct segments of curved line stitching. The areas are transformed into

another coordinate space where known calculation methods for straight line

stitching are used to calculate straight line fills of the transformed area. The

resulting area and stitches are then transformed back to the original coordinates,

resulting in even stitching along smooth curves which fills the original area such

that the intermediate stitch penetration points along the curves form a smooth

continuous visual pattern throughout the area.

it is common practice is to fill areas with stitches with straight stitch lines which are

parallel to each other. The lines may be vertical, but other angles are also used.
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Self-Check -1 Written Test

Directions: Answer all the questions listed below. Use the Answer sheet

provided in the end page:

1.Types embriodery stitch Used for outlining small items and widths less than 1

mm or simply to walk from one part of the design to the other is..............(1pt)

A. Running B. Fill stitch C.Walking Stitch D. A and C

2. List types of embroidery Stitch(3pts)

A.______________________________

B.___________________________

C.______________________________

3.define what is Embroidery(2pts)

4.What is monochromatic color scheme(2pts)

5.What is Motif? (2pts)

Note: Satisfactory rating – 10 points Unsatisfactory below 10points

You can ask you teacher for the copy of the correct answers.

Answer Sheet

Name: _________________________ Date: _______________

Score = ___________

Rating: ____________
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Information Sheet-2 1.2.Identifyimg available software programs.

 PE-design brother Embroidery Software System

Brother ELS Embroidery Lettering Monogramming software is an in-house

accessory made by the Brother company. It is best suited for their embroidery

machines, of course, but it can work with other brands as well.

The software comes with 20 built-in pre-digitized fonts, 5 monogram styles, but

also with more than 40 decorative frames, 14 decorative fill patterns, and 3 built-in

text styles.

The Brother ELS Embroidery Lettering Monogramming software is recommended

for both advanced and beginners because it has a very easy to use interface.

Even though it can work on older computers, it is only available for PC.

With Brother software you will have the ability to digitize images, combine and edit

designs, select the perfect font, and more, giving you all the tools you need to

construct new designs and patterns.

Brother embroidery software is designed to be easy to use, so that you can truly

express your creativity.

Installation of the software

In order to start using the software you have to first install the contents of the CD

to your PC. This procedure is referred to as “instal-lation procedure”. Please

follow the below listed instructions in order to successfully install

This section describes how to install the application software.



Federal TVET Agency
Author/Copyright

TVET program title-Advanced Apparel Production
Level III

Version -1

December,2020
Page 16 of 155

1. Insert the enclosed CD-ROM into the computer’s CD-ROM drive.

Fig2.1.computer

→ After a short while, the Choose Setup Language dialog box automatically

appears

2. Select the desired language, and then click OK. → The InstallShield Wizard

starts up, and the first dialog box appears.

3. Click Next to continue with the installation. → A dialog box appears, allowing

you to select the folder where the software will be installed.
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4. Click Next to install the application into the default folder. → When the

installation is completed, the dialog box shown below appears.

5. Click Finish to complete the installation of the software.

 What You Can Do With PE-design Personal Embroidery Design Software

System

This Software This software provides digitizing and editing capabilities, allowing

you the creative freedom to design original embroidery. Easily turn illustrations,

photos and lettering into custom embroidery designs.

Automatically Create an Embroidery Pattern From an Image
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Automatically Create an Embroidery Pattern From a Photo

Easily Create Custom Font Patterns Custom fonts can be created using Font

Creator. These fonts can be recalled to be used in Layout & Editing.

Have Fun Creating Embroidery Patterns Manually

You can combine embroidery patterns or apply stitching to drawings and text. In

addition, you can design a wider variety of embroidery patterns by using the many

sew types available.
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 BERNINA Embroidery Software

BERNINA Embroidery Software contains hundreds of ready-to-stitch designs,

including many attractive ornaments, samples and digitizing backdrops. Design

files (ART files) and images (BMP, JPG, and WMF files) can be found in your

Embroidery and Picture libraries.

BERNINA Embroidery Software includes its own Embroidery Library design

management application to view and manage your embroidery designs.

Alternatively, explore design folders using MS Windows® Explorer.

Sew a ready-made design For many embroiderers, it is enough to take an existing

design and stitch it out. This is certainly where most will start. Once you have

found a design you like, you will want to preview it to see how it will sew out. A

number of steps are involved. We outline the main ones here with reference to the

manual.

To sew out a design

1 Open the design in BERNINA Embroidery Software. See Opening designs for

details.
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2 Adjust viewing settings as desired. See Viewing Designs for details.

3 Check the fabric type and change as necessary. See Status bar for details. 4

Check thread colors and if necessary, change charts to suit the one you are using.

See Assigning thread colors for details.

5 Preview the stitchout so you understand how the design will sew on the machine.

See Viewing stitch sequence for details.

6 Choose a hoop and check location within the hoop. See Selecting hoops for

details.

7 Preview the design and print out a design worksheet before sewing out as

desired. See Printing designs for details.

8 Send the design to machine directly or via data media (usually memory stick).

See Stitching out designs for details. Check your BERNINA machine

documentation for steps involved after transferring the design to machine.

Typical embroidery software allows to create embroidery design files that define

parametrized embroidery objects such as lines, sating columns or fill areas. These

objects can be created directly through technical drawing or be translated

(digitized) from vector drawings. From embroidery objects one can generated

stitches that then can be exported to proprietary machine (stitch) formats that can

uploaded to an embroidery machine.
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Most software includes machine-specific features. On older machines, one has to

pay attention to connectivity. Some machine types use specially formatted

memory cards or USB sticks (or some other weird specifics) and do require

special software to write CNC files. Usually this type of software is offered for free

(either when you buy the machine or for download). The same software then also

can convert, resize, rotate and preview.

There are different types of software programs – Editing programs to resize or

merge designs and convert the designs into different formats;

BERNINA Embroidery Software, you’ll be pleased with its flexible digitizing

capabilities, the ease with which you can create and edit designs, and how simple

it is to add or create your own lettering.

BERNINA Embroidery Software provides embroiderers with a fast, flexible way of

creating and editing embroidery designs.

 Embrilliance embroidery software

Every person who is passionate about creating embroidery designs needs the

means to perform basic modifications and enhancements to their work. These

simple revisions should be done in a relaxed manner and should bring you

pleasure while working. The Embrilliance company understood that and designed

the Embrilliance Essentials software to make your work fun and easy.

Their product is compatible with the operational systems from both Mac and PC

and is perfect for things such as merging, resizing stitches, removing overlaps or

changing colors.

Embrilliance Essentials software is best compatible with the computerized sewing

machines produced by the Brother company.

Embrilliance embroidery software and fonts will have you designing and digitising

in minutes, no matter your skill level or experience. With a range of software
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products and levels to choose from you can tailor an embroidery software suite to

suit your needs. Building your suite is easy - simply download the free foundation

program, Embrilliance Essentials, then add a serial number to upgrade the

modules you want to use. All of the features and upgrades you purchase will

appear in the one Embrilliance program. The generous software licence means

you can run it on as many computers as you need. You can even mix and match

between Mac and Windows.

What does Embrilliance software do?

You can move, remove, rotate, copy, paste, recolor and re-use any part of your

design, any way you like! From a simple alteration to a complete design makeover,

Enthusiast lets you make the most of your design collection! ... Is your satin stitch

border leaving gaps?

Digitizing programs which is useful in digitizing images that you scan and feed

into the program, ready to be embroidered.

To choose the best software program is not so easy but luckily most of them have

trial versions. First of all, you have to decide on the purpose and what you want

from the program. And also the skill you have in using a computer. Most programs

have a learning curve and you will have to make an effort to learn the basics and

realize that you can become an expert only after several hours spend tinkering

with it.

Embroidery software is a great tool for changing thread colors. While thread

colors can be changed without it, using software allows you to preview the

changes on the screen before stitching. Thread colors in embroidery software are

an approximation of the color, and may look different from one computer screen to

another.

Embroidery software also allows color changes to various design parts, and helps

eliminate unwanted color changes. To change the colors of the bear’s suit,
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featured below, from red to blue by changing all red thread also changes the

bear’s tongue blue (D). Embroidery software easily fixes the color changes.

The Types of Embroidery Software

With so many types of modern embroidery machines, picking the right one might

become a trouble. Now, read about each category in order to understand the

differences:

Digitizers

The Digitizers are those types of software meant to convert the image for the

embroidery file free, so it will be ready for stitching. What it actually does is to

translate or digitize the vector format into a stitch. Once this happens, the vector

format is ready for use.

Vectorizers

What this type of software does is to translate or digitize a picture in bitmap format

into a vector format, or a vectorize one. Now, what does this mean, on everyone’s

language? It means that the image goes through a linear transformation, meaning

that the image is ready for digitizing.

Lettering

Also known as the monogramming software, the lettering type, as the name

suggests, is meant to create optimized stitching fonts. Whether you enjoy to

combine different lettering and modules, or just focus on other things related to

lettering, this type of software is going to help you.

Editors
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While the previous types of software were more technical, the editors give access

to a more creative part of the design. So, using editors, you can begin fresh and

develop all the vectorizing or the digitizing stitches.

Embroidery Designs That The Software Offers

Another important aspect to look for when choosing the best embroidery machine

is the designs the software is offering. Remember that some embroidery

machines have only a few designs built into their memory.

So, what types of patterns does the machine offers? For instance, some have

various built-in features, like the one I previously talked about. Designs, patterns

or lettering are some of them.

Ease of using

You may not want to hear this, but there is no reason on buying a very performant

embroidery machine if you are a beginner in this domain. Are you going to use the

machine in business purposes, for mass production and continuous hours of

operation or just for relaxing after a hard day at work?

Is the machine going to satisfy just a hobby, or to be the principal pawn for mass

production? Depending on your purpose, purchase an embroidery machine that is

easy to use, so it is worth the investment.

Compatibility

Forget everything and pay attention to the most important aspect of purchasing an

embroidery machine. It is crucial for the machine to work with your current devices.

Pay attention to this part: if you think that all software is compatible with most of

the devices, you are all wrong. This is why is so important to check if the

embroidery software is compatible with Windows PC or Mac.
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To avoid any miss-purchasing, you should read all the details of the future

product.

Brand

This is a more subjective principle when choosing the embroidery machine. Some

people may consider all the brands to be of good quality. But just to be sure, I

recommend you to read forums, blogs, and other information from different users

to figure out which is the right choice for you.

The benefits of embroidery software

Just to take a picture of them, here are a few of the embroidery software’s benefits

that is most important:

1. See the design before embroidering

You save a lot of time while seeing the designs on your computer. You choose the

perfect one for you, without re-downloading them or re-purchasing one you

already have.

2. Personalization

The Embroidery Software allows you to put text on your designs, to restyle them,

or to put op-to-date the sizes and properties. This means an always personalized

design and an expression of your true creativity.

3. Preview how the final design will look

This feature is one of the greatest, as it allows you to change the colors, the

design, the fonts, so they will suit your wishes. No more guesswork, just on-time

design creation.

4. Render the sizing
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Although you are told that the machine has only a 4”x 4″ sewing area, by

downloading an embroidery software, you can render the actual embroidery area

and make it recognizable to the machine.

5. Editing

Once you download an embroidery software on your computer, it’s time for editing

the designs you want. You can add text, make them larger, smaller, remove some

unnecessary parts or merge 2 designs together.
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Self-Check -2 Written Test

List and explain the following questions as required

1.Mention and compare different embroidry design software(3)

2.List and explain benefits of embroidery software(5)

3.What is Digitizers(2)

Note: Satisfactory rating – 10 points Unsatisfactory - below 10 points

Answer Sheet

Name: _________________________ Date: _______________

Score = ___________

Rating: ____________
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Information Sheet-3 1.3.Identifying garment considerations.

1.3.1.Type of fabric

With so many different fabric types available to the modern embroiderer, it can be

hard to know which type of material is best to use with your embroidery designs

and when to use them.

When it comes to fabrics used in machine embroidery, there are 3 main

categories based on how certain fabrics are produced:

 Nonwoven fabrics, such as felt

 Woven fabrics, such as cotton, linen, silk, wool, and polyester

 Knitted fabrics, such as yarn and French terry cloth

Choosing the Right Fabric for Your Embroidery Design

When choosing your fabric you need to consider the weight of the embroidery

design. The fabric needs to be strong enough to hold the design. Looser fabrics

are less able to hold the threads. If you want to use a specific type of fabric, you

need to select a design that is suitable for the weight of that fabric. The ‘thread

count’ of the fabric refers to the fabric’s weave and determines the ability of the

fabric to permit a needle to thread through it without difficulty.

1.3.2.Color of fabric

How can I preview my fabric and choose thread colors to match?

When you’re choosing colors for your embroidery designs, software makes it

simple by letting you color the design on-screen before you stitch it out.

Sometimes background fabric needs to be considered, too.

Choosing Fabric Colors



Federal TVET Agency
Author/Copyright

TVET program title-Advanced Apparel Production
Level III

Version -1

December,2020
Page 29 of 155

Fabrics used for embroidery are available in different thread counts and are

available in cotton, linen, and blends. Your selection of fabric will depend on what

you are planning to make and the embroidery technique you are using. Here's a

basic run-down of the most common embroidery fabrics you will find in stores, as

well as unconventional sources available in home stores.

You'll want to start by testing your fabric marker. You should get some scrap fabric,

and maybe make a few stitches of embroidery in it, to use for testing.

Unfortunately, you probably have no idea what the fiber of the embroidery thread

is made from, so you won't be able to be sure that it will take it as well as your test

thread does. Synthetic fibers may take the color from a fabric marker more lightly

than a natural-fiber yarn would do.

contrast in color or value is what will make the appliqués pop. Use the color wheel

to help select fabrics

Complementary colors (opposite on the color wheel) are a tried and true combo.

Love the base fabric? Place it on a color wheel and move your eye across the

wheel. There’s your applique fabric. This method works beautifully and

guarantees eye-catching results.

1.3.3.Positioning of design

The success of any embroidery project is depend upon the correct placement of

the design and completion of the project. Using pinpoint placement feature on

BERNINA embroidery machines made placement so easy, and I have a perfectly

placed embroidery border.

How to Achieve Perfect Placement for Machine Embroidery Designs

template Tips

Paper templates are the key to perfect embroidery placement. These full-sized

representations of embroidery designs are printed in either black and white or

color. Most templates have intersecting lines marking the design center.
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 Templates are often included with design collections as a PDF. Some

designs include preprinted templates ready to be cut out.

 If a design collection doesn’t include templates, open the design in either

an embroidery editing, sizing or digitizing software program. Adjust the

software settings to include the vertical and horizontal centerlines.

If using a design light in color, change it to black in order to create a template.

Print the placement template, ensuring the software prints the design at 100%.

Watch for “scaling” or “print to fit page” in the print screen, as these features

change the template size.

Embroidery design file guidelines

Embroidery machines need to be told where, when and how to place the stitches

required to create your design, and this information can't be coded into a standard

image file, like a PNG or JPG. For that we need something a little more

specialised: we need to digitise your design file.

But before we digitise your artwork, there are some guidelines that need to be

followed to make sure your design is suitable for embroidery. These guidelines

apply to every product we embroider.

Design file guidelines for flat embroidery
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Embroidery is great. It's durable, vibrant, and looks fantastic. But it has some

limitations imposed by the production method, which means your design file will

need to meet certain criteria to be suitable for digitising.

Maximum size of embroidery

This varies depending on the product you're having embroidered:

Fig3.1 positioning of design.

1.3.4.Suitability of size, design, color

design considerations

There are a number of considerations to keep in mind when designing a logo you

want embroidered.
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Embroidery is not the same as printing. What looks good on a business card may

not work for embroidery.

Thread is of a standard thickness, approx 0.4mm. Tiny strokes for emphasis and

small lettering are often not possible in embroidery.

Frequent colour changes increase the probability for thread breaks during

embroidery. When designing, try to draw the design without lifting the pencil from

the paper for each colour. This is what we aim for when we convert the design to

stitch format.

Shading is easier to do in Screen printing and on paper than it is in thread.

There is a limit to letter sizes. Lettering below 5mm seldom embroiders crisply.

Not all stock designs are scalable.

Small lettering, excessive detail or very small shapes don't lend themselves to

reproduction in thread. They are difficult to work with, and don't look good on the

finished product. Lettering should be at least 5mm high or taller to sew out best.

An embroidered design is a special kind of graphic. It is made of thread instead of

ink, so it has a different texture and sheen.

Perfect Embroidery Design Placement: Single Designs

How to determine the embroidery placement measurement.

For finding exactly where you should place the design accurately, measure the

width of the item, usually on clothes from one side seam to the other side seam or

if there is a placket, from the placket to the side seam. Divide this measurement

by two. Mark this measure as a small vertical line. Mark the distance from the top

seam/edge. Mark this as a horizontal line. The center point of these two lines will
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form the middle of your embroidery design placement unless otherwise

mentioned.

What colors should I wear?” : Factors affecting Color Trends for your clothes

Color is everywhere, affecting our moods, our fashion sensibilities, even our

appetites. It is the first thing you notice when you look at something. So when it

comes to selecting clothes, color plays a very big role.

The same garment that looks beautiful on one person can look hideous on

another. One of the major factors that result in this difference in visual

perception is the color of the garment. Hence designers are particularly concerned

about the best use of colors in their creations. Color is at the center stage of

fashion.



Federal TVET Agency
Author/Copyright

TVET program title-Advanced Apparel Production
Level III

Version -1

December,2020
Page 34 of 155

Self-Check -3 Written Test

Answer the following question

1.List different Types of fabric(3pts).

________________________________________________________________

____________________________________________________________

2.Fabric selection for embroidery depends on(2pts)

________________________________________________________________

_____________________________________________________________

Note: Satisfactory rating – 5points Unsatisfactory - below 5 points

Answer Sheet

Name: _________________________ Date: _______________

Score = ___________

Rating: ____________
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Information Sheet-4
1.4.Identifying Machine requirements.

1.4.1.Thread type

Different sewing threads and their uses…

Different types of Embroidery threads in use are, Rayon Threads, Polyester

Threads,� Nylon threads,� Cotton Threads,� Cotton-wrapped

polyester,� Metallic Threads,� Laminate or Flat Threads and Silk Threads:

With a large variety of different threads available it can be a minefield finding the

right thread for the job, especially if your relatively new to sewing.

 Polyester is your go-to everyday thread, it can be used on a variety of different

projects for both hand and machine sewing. Polyester thread has a small

amount of ‘give’ and is therefore suitable for use with stretch and knit fabrics.

It is strong and durable so can be used on projects that will receive a great

deal of wear and tear. It is generally available in the largest color range.

 Cotton thread is the perfect accompaniment to 100% cotton fabric and is

therefore most commonly used in patchwork and quilting. Some sewing

purists believe that you should use the same thread as the fabric yarn content,

so cotton thread should be used to sew cotton fabric.

Cotton thread has very little ‘give’ and is weaker than other available threads,

such as polyester. But it can be perfect for use on lightweight, delicate projects as

generally speaking you want the thread to be weaker than the fabric your working

with, so any stress on seams causes the thread to break, rather than the fabric to

tear.

 Silk is a beautiful thread to work with; both on and off the sewing machine. I

predominately use silk thread when hand sewing; finishing hems, basting

(tacking), buttonholes and tailoring work. Silk thread is very smooth so travels

through even the lightest most delicate fabrics without leaving a mark, as well

as being very strong (especially when used in conjunction with beeswax), it is

a superb choice for a large variety of hand sewing projects.
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Uses for topstitching thread?

Topstitching thread is as the name suggests suitable for topstitching. Although

standard thread can be used for topstitching the thicker topstitching thread is

perfect for use on heavier weight fabrics and provides a decorative look to

stitching.Try increasing your stitch length to get a better finish; generally speaking

the thicker the fabric the larger the stitch length required (the standard stitch

length of 2-2.5mm will disappear in thick fabrics such as denim and canvas).

Sewing with decorative threads (metallic & embroidery)?

Metallic and embroidery threads are fabulous for machine or hand embroidery,

creating decorative detailing on garments and home decor projects. With a large

variety of different threads available and a super colour range you should be

overwhelmed with choice.

Remember to use a specialist needle when working with metallic and embroidery

threads to prevent shedding and snapping of the thread.

Choosing the best thread?

So what do you need to think about when choosing the best thread for your

project?

Think about fabric properties, is your fabric woven or knitted, lightweight or

heavyweight?

The weight of the thread should match the weight of the fabric.

Some sewing purist recommend matching the thread to the fiber content of the

fabric (cotton thread to cotton fabric).

Most of the time an all-purpose polyester thread will worktry and stay away from

cheap threads, when working with threads you generally get what you pay for

colour choice is up to you; do you wish to achieve a colour match or use thread in

a contrasting colour as decoration
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If apparel sewing threads are used for embroidery these need to be carefully

tested to avoid garment issues. These threads are developed for industrial sewing

machines where speeds can exceed 4,000 rpm. The quality and quantity of

lubricant used in these sewing threads is different to that of embroidery threads

and helps to minimise the friction and abrasiveness while the machine is running

at these higher speeds. If apparel sewing threads were to be used for embroidery

the lubricant can potentially migrate from the thread and stain the fabric. The

lubricant used for embroidery threads is lower and more tightly controlled to allow

high performance, outstanding quality, and to minimise the risk of stains.

polyester and rayon continuous filament embroidery threads are now in

widespread use all around the world.

Polyester threads, in particular, are now becoming more popular because of their

ability to with-stand more demanding washing and dry cleaning performance

standards. Polyester has advantages over rayon in terms of superior dry and wet

strength, abrasion resistance and shade fastness / colour retention.

Embroidery Thread Most designs are digitized for 40 weight rayon or polyester

thread, which are the most commonly used types by machine embroiderers. Both

have a beautiful rich look; both are widely available. Polyester is stronger, more

colorfast, and more abrasion resistant making it especially good for embroidering

children’s clothing. Polyester is also usually more economical than rayon. Select

high-quality embroidery thread because bargain brands may cause excessive

thread breakage while stitching and may produce undesirable final results.

Specialty threads such as metallics, acrylics, and silk may also be used but are

often employed as accents rather than for full designs.

1.4.2.Needle type

Needles are available in different sizes with different points for different fabrics.

The needle penetrates the fabric, taking the thread under the fabric and catching

the bobbin thread to form stitches without causing any damage to the material.
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Select the type of needle based on the textile construction (i.e knit vs woven), and

the needle size is determined by the thickness of the thread and the weight of the

fabric used for swing.

Fig.1.4.2. Parts of needle

There are two needle sizing system: Americanand European. American Needle

sizes range from 8 to 19, and European sizes range from 60 to 120. Higherthe

number,larger the blade of the needle.

Specifications of the embroidery needles

DB x 1(#55) needle has been used for all the embroidery samples.

1.4.3.Stitch settings

Stitch and Sew fills in the shapes you create (using the Lettering or Freeform or

Column tools) with stitches.

Because of the wide variety of fabrics and differences in the way they behave

when stitches are applied to them, it is important to be able to adjust how the

stitches fill these shapes. The Embroidery Settings dialog box controls a lot of this,

especially these 3 key settings:

-Stitch density (3.5 to 4.0 is normal, 2.0 is heavier density, 5.0 and up is lighter

density)

- Underlay - how much and what type of supporting stitching (known as underlay)
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- Stretch - The amount of overlap that an area of stitching needs to sew beyond

the shape of the objects. Generically in the industry this is known as “Pull

Compensation”.

Fig.1.4.3.different stitch setting

1.4.4.Spool requirements
 Thread spool comes in a wide variety of weights and types

Fig. 1.4.4.thread color and spool
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Self-Check -4 Written Test

Answer the following questions as required

1.What are the criteria for Choosing the best thread for embroidery?(3pts)

2.Polyester threads are more popular for embroidery than rayon threads

today,why?(2pts)

3.Embroidery needle should be selected based on types of fabric(1)

A. True B.false

4.list parts of embroidery needle(4pts)

Note: Satisfactory rating – 10points Unsatisfactory - below 10 points

Answer Sheet

Name: _________________________ Date: _______________

Score = ___________

Rating: ____________
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LG #28 LO #2- Create original design

Instruction sheet

This learning guide is developed to provide you the necessary information regarding the

following content coverage and topics:

 Developing OHS practices.

 Preparing and creating design concepts.

 Reviewing designs

 Developing design concept using appropriate tools and equipment.

 Developing design specification.

 Performing routine minor maintenance.

 Organizing, protecting and storing designs.

This guide will also assist you to attain the learning outcome stated in the cover page.

Specifically, upon completion of this Learning Guide, you will be able to:

 Develope OHS practices.

 Prepare and create design concepts.

 Review designs

 Develop design concept using appropriate tools and equipment.

 Develop design specification.

 Perform routine minor maintenance.

 Organize, protect and store designs.

Learning Instructions:
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Read the specific objectives of this Learning Guide.

1. Follow the instructions described below.

2.Read the information written in the “Information Sheets”. Try to understand what are being

discussed. Ask your trainer for assistance if you have hard time understanding them

3.Accomplish the “Self-checks” which are placed following all information sheets.

4.Ask from your trainer the key to correction (key answers) or you can request your trainer to

correct your work. (You are to get the key answer only after you finished answering the

Self-checks).

5.If you earned a satisfactory evaluation proceed to “Operation sheets

6.Perform “the Learning activity performance test” which is placed following “Operation

sheets” ,

7.If your performance is satisfactory proceed to the next learning guide,

8.If your performance is unsatisfactory, see your trainer for further instructions or go back to

“Operation sheets”.
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Information Sheet-1 2.1.Developing OHS practices

2.1.1.Manual handling techniques

Handles or holders should be attached to loads to reduce the chances of getting

fingers pinched or smashed.Workers also should use appropriate protective

equipment. For loads with sharp or rough edges, wear gloves or other hand and

forearm protection. In addition, to avoid injuries to the eyes, use eye protection.

2.1.2.Standard operating procedures

Standard operating procedure(SOP) can be defined as a step-by-step written

procedure about how to do a job that gives desired result and maintains

consistency in results. SOP can also be defined as a checklist for the user

(operator) who is going to do a particular job. SOP is a sure success method of

doing a job.

More than just written instructions SOP can be also made using illustrations and

flow charts. For some processes factory only needs to provide detailed

instructions to perform a task, where some processes required instruction as well

as decision making based on result of intermediate steps.

2.1.3.Personal protective equipment

Personal protective equipment (PPE) is protective clothing, helmets, goggles, or

other garments or equipment designed to protect the wearer's body from injury or

infection. The hazards addressed by protective equipment include physical,

electrical, heat, chemicals, biohazards, and airborne particulate matter.

2.1.4.Safe materials handling
Material handling is accompanied by numerous risks, especially when done

manually. Tasks such as lifting, carrying and pushing can make the workplace

unsafe for employees. Material handling injuries can also be quite expensive with
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medical costs, lost productivity and decreased employee morale. As an

organization, you must take preventive measures to minimize injuries and the

costs associated with them.

2.1.5.Taking of rest breaks

Taking breaks that are truly restful and get us into that diffuse mode of thinking

can refresh our ability to concentrate and help us perform better when we return to

work.

The study broke up break activities into four categories:

Relaxing (daydreaming, stretching)

Nutrition-based (coffee,tea)

Social (chatting with colleagues)

Cognitive (reading emails or the newspaper)

Even if you are taking regular breaks, you might not be giving yourself the best

chance to refresh your focus.

2.1.6.Ergonomic arrangement of workplaces

Ergonomic risk factors are those problems that cause unnecessary physical

fatigue in employees. These risk factors are commonly found in the manual

material handling environment. Three primary factors include stressful postures

while handling materials like bending or twisting, highly repetitive motions such as

frequent reaching and lifting, and forceful exertions like carrying or lifting heavy

loads. Identify all such ergonomic risk factors and minimize them by putting

control measures in place to limit the exposure of employees to all possible risks.

2.1.7.Following marked walkways
Every movement or walks is the given area in the working class or room.



Federal TVET Agency
Author/Copyright

TVET program title-Advanced Apparel Production
Level III

Version -1

December,2020
Page 45 of 155

2.1.8.Safe storage of equipment

Safely operate handling equipment

1.List general safety rules for common handling of equipment.

2.Relate equipment operation to personal safety.

3.Identify locations where hazards are greater for equipment operation.

2.1.9.Housekeeping

housekeeping refers to the routine cleaning and organizing of the workplace. As

housekeeping is an ongoing safety practice, orderly conditions in the workplace

should be maintained on a consistent basis, not restored after orderliness has

been allowed to slip.

Housekeeping operations in the workplace are considered to be a fundamental

tenet of occupational safety and are a mandatory workplace safety activity in most

jurisdictions.

Improper housekeeping can increase the risk of a variety of accidents.

2.1.10.Reporting accidents and incidents

Workplace Health and Safety (WHS) is the discipline concerned with protecting

the health and safety of all stakeholders in the workplace from exposure to

hazards and risks resulting from work activities.
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Self-Check -1 Written Test

1.Which is not true about Standard operating procedures(2pts)

a.method of doing a job.

b.SOP can be using illustrations and flow charts

C. It is checklist for the user d.none

2.Tasks such as lifting, carrying and pushing can be categorized under(2pts)

A.materials handling

B.Take rest break

C.Protective equipment

D.Working procedure

3.Improper housekeeping can increase the risk of a variety of accidents(1pts).

A.true B.false

Note: Satisfactory rating – 5points Unsatisfactory - below 5 points

Answer Sheet

Name: _________________________ Date: _______________

Score = ___________

Rating: ____________
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Information Sheet-2 2.2. Preparing and creating design concepts

How to Make Your Own Embroidery design

Making your own embroidery pattern involves two interdependent steps;

designing the pattern and bringing it to life on a digital embroidery machine. In the

first step, you create your own embroidery design by hand and digitize it on any

embroidery software of your choice. Examples of embroidery design software

include; Embrilliance Stitch Artist, BuzzSize, Brother Initial Stitch Embroidery

Lettering & Monogramming Software, among others.

In the second step, you print out your design and bring it to life on your choice

modern digital embroidery sewing machine to sew the intricate patterns. You

can also create a collection of embroidery patterns and add them to your

collection for future projects. There is a ready market for unique embroidery

patterns out there.

Creating and Editing Embroidery Patterns

Using Design Center In this section, we are going to manually create an

embroidery pattern from an image using a some-stage procedure. This pattern will

be used later as the stepping stone to create a more complex embroidery pattern.

Follow the instructions in this section step by step. If you have to interrupt this

exercise for any reason, it is recommended to save the file “Saving the file”, on.

You will be able to retrieve it later and resume your work. The complete procedure

will take you through the different steps of a normal working session with Design

Center and will introduce you to its most important features.

Step 1 Starting up Design Center

1. Click , select All Programs, then PE-DESIGN Ver.6. Select Design

Center to open the Design Center window.
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→ The How do you want to produce embroidery? dialog box and the Design

Center window appear.

Step 2 Opening an image file First, we need to open the image that will be used to

create the embroidery pattern.

1. In the How do you want to produce embroidery? dialog box, click .

→ The From Image dialog box appears.
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3. Select the sample file Flower.bmp in the Data folder.

4. Click Open to open the image file and to close the dialog box.

→ The image appears in the Design Page and in the Cut out to Line Image dialog

box.
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Click any part of the outline.

→ The selected color appears in the top box under Pick Colors, and appears in

the check box to show that the color is selected.

Click Preview to preview the line image in the Design Page.

When the line image appears as desired, click OK.

→ The line image is displayed in the Design Page.

Step 4 Editing lines

At this time, you might need to correct a few lines in the line image. You should

make sure that regions are completely enclosed by either a single closed line or

intersecting lines. You may also want to edit the line image and either add or

remove some details. You can do this at this time using the pens and erasers in

the Tool Box. In this example, we are going to display the line image enlarged to

make editing easier, then use an eraser to remove some of the outline.
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Previewing the image You can display a preview of the embroidery pattern in

order to see how the stitching is connected, or you can display a realistic preview

of the embroidery pattern in order to see how the pattern will appear once it is

sewn.

1. To display a preview of the embroidery pattern, click Display on the menu bar,

and then click Preview. An alternate method is to click the Toolbar button

indicated below.

→ A preview of the embroidery pattern appears.

To display a realistic preview of the embroidery pattern, click Display on the menu

bar, and then click Realistic Preview. An alternate method is to click the Toolbar

button indicated below.
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→ A realistic preview of the embroidery pattern appears.

To leave the realistic preview display, repeat step 3., or press the key.

Saving the file Since this embroidery pattern will be used as the basis of a more

complex embroidery picture, we need to save it.

1. Click File on the menu bar, and then click Save As.

2. → The Save As dialog box appears.

2. The default name Flower.pem is displayed.

3. 3. If necessary, change the drive and folder. 4. Click Save to save the file.



Federal TVET Agency
Author/Copyright

TVET program title-Advanced Apparel Production
Level III

Version -1

December,2020
Page 53 of 155

Information Sheet-3 2.3.Reviewing designs

Why Design Reviews?

Embroidery Software provides many viewing features to make it easier to work

with your design. Zoom in on an area to see more detail or view the design at

actual size. Show or hide various design elements with the available display

settings. Preview an existing design in different colors on different fabrics.

When working with embroidery designs, you need to understand the stitching

sequence. You can check a design’s stitching sequence in Embroidery Software

by ‘traveling’ through it stitch-by-stitch. You can also check the sequence by

simulating the design stitchout on screen. Embroidery Software also provides

information about designs in a variety of ways and formats. Before even opening

Embroidery Software or your design, you can check some design information for

ART files directly from MS Windows Explorer. You can view stitching details about

a design in the Design Properties dialog. Also the Print Preview provides essential

design information, including a design preview, the size of the design, color

sequence and any special instructions. This section explains the design viewing

modes available in Embroidery Software as well as the various design viewing

settings. It describes zooming and panning as well as how to view the stitching

sequence. It covers displaying design backdrops and changing backgrounds. It

also explains how to obtain information about your designs.

Embroidery view settings

You can show or hide embroidery elements in Embroidery Canvas with a variety

of display settings. See a graphical representation of the final embroidery. Show

or hide needle penetration points and stitches themselves. Or show/hide selected

colors.

You can show or hide stitches and object outlines as you work. For instance, hide

stitches to see outlines more clearly when reshaping.
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Zooming & panning

Use the Overview Window and Zoom functions to quickly examine your design at

different degrees of magnification.

Zooming in and out

Magnify your view of the design by zooming in on individual stitches or details, or

zoom out to display more of the design in the window.

Zooming You can zoom in to work on details of the embroidery pattern or you can

zoom out to work on any part of the embroidery pattern that cannot be viewed in

the work area.

Viewing stitch sequence/ Editing the sewing order

When working with embroidery designs, you need to understand the stitching

sequence. You can check a design’s stitching sequence by ‘traveling’ through it
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by stitches, colors or objects. You can also check the sequence by simulating the

design stitchout onscreen. BERNINA Embroidery Software simulates stitching out

by changing stitches from black to their allocated thread colors as they are

‘stitched’

The sewing order can be changed by selecting the frame containing the pattern

that you want to move, then dragging the frame to the new location. A vertical red

line appears, indicating the position where the frame is being moved.

Viewing design information

Embroidery Software provides information about designs in a variety of ways and

formats. Before even opening Embroidery Software or your design, you can check

some design information for ART files directly from MS Windows® Explorer. You

can view stitching details in the Design Properties dialog. The Print Preview tool

provides essential design information, including a design preview, the size of the

design, color sequence and any special instructions.

Viewing designs in Windows Explorer

Before opening ART files, you can view design thumbnails and details via MS

Windows® Explorer. The Properties dialog displays a design preview together

with design information such as stitch count, number of stops and color changes.

You can also view general file information, such as file size and modification dates.

Design thumbnails are displayed in Windows Explorer.
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Fig.1.3.1.preveiw embroidery design print veiw

Before we get into things, we need to address this question: What is the purpose

of a design review?

“Design is about the customer, not the user.”

Design reviews exist to persuade stakeholders that you’re offering the best

solution at the intersection of customer and business needs.

Your embroidery software provides many viewing features to make it easier to

work with your design. Zoom in on an area to see more detail or view the design at

actual size. Show or hide various design elements with the available display

settings. You can show or hide needle penetration points, connectors and the

stitches themselves.
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Viewing methods Your design software provides many viewing techniques to

make it easier to work with your designs. Turn on or off design artwork. View

selected parts of a design. Zoom in on an area to see more detail or view the

design at actual size. The View toolbar and menu provide access to most of the

viewing options you will need.

View selected parts of a design

You can set your system to display all embroidery objects in a design, or hide all

but the selected objects. � To display selected objects, select View > Zoom >

Zoom to Selected or press
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To fit the whole design in the design window, select View > Zoom > Zoom to Fit or

press <0>. � To view the design at actual size, select View > Zoom > Zoom 1:1

or press <1>. See also Monitor calibration.

View stitches

The software lets you show or hide stitches in your design. This is useful when

viewing stitches for editing.

View needle points

The software lets you show or hide needle points in your design. This is useful

when you want to select stitches for editing. To view needle points, click the

Display Needle Points icon or select View > Display Needle Points.
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Self-Check -3 Written Test

Explain the following

1.By Reviewing designs in details we can get different advantages,list some of it

________________________________________________________________

________________________________________________________________

_____________________________________________

2.By Zooming the design we can observe:

________________________________________

Note: Satisfactory rating – 5points Unsatisfactory - below 5 points

Answer Sheet

Name: _________________________ Date: _______________

Score = ___________

Rating: ____________
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Information Sheet-4
2.4.Developing design concept using appropriate tools and
equipment.

2.4.1.Computer

Computers have been making all of our lives easier for decades, especially when

it comes to embroidery. What used to take hours to do by hand with a needle can

now be completed in a matter of minutes with a computerized embroidery

machine.

Fig.2.4.1.computer parts

Computer hardware refers to the physical devices that make up a computer.

Examples include the keyboard, monitor.

Hardware devices can be classified into four distinct categories:

 Input devices: For raw data input.

 Processing devices: To process raw data instructions into information.

 Output devices: To disseminate data and information.

 Storage devices: For data and information retention.
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1. Input Devices

Components which are used to input raw data are categorized under input

devices. They aid in feeding data such as text, images, and audiovisual

recordings. They even aid in file transfers between computers.

e.g. keyboard is the most commonly used input device.

2. Processing Devices

Processing is the core function of a computer. It is the stage where raw data is

transformed into information. Once data has been processed, it can be used for

useful purposes.

Components that manipulate data into information are categorized under

processing.

Data is stored temporarily in processor cache and primary memory during the

processing period.

3. Output Devices

Hardware components that disseminate and display both data and information are

classified under the output category.

These components are sub-categorized under softcopy and hardcopy output.

Softcopy output includes the intangible experience. The user derives visual

satisfaction

4. Memory/Storage Devices

Components that retain/store data are classified under memory/storage devices.
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2.4.2.Software programs

3 main types of embroidery file formats

Expanded File Formats: These formats are commercial embroidery machine

formats such as .dst and .exp. They are the smallest files in size and mainly

consist of simple x and y movements and commands for your embroidery

machine to follow.

Machine File Formats: These file formats are specific towards different

embroidery machine brands and tell your machine the commands necissary to

embroider designs. They include .jef, .art, .hus, .vp3, .vip, .pes, .pec, .xxx, .pcd,

etc.

Native File Formats: These file formats can not be read by any embroidery

machine but rather can be read and written by embroidery software. These are

the best “working files” to edit a design with and are later converted into a machine

or expanded file formats to run on your machine.

2.4.3.Hardware peripherals such as scanners, printers

Printer

A printer is an external hardware output device that takes the electronic data

stored on a computer or other device and generates a hard copy.

Fig.2.4.2.printer
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scanner

A scanner is a photographic device, usually stationary, which progressively

captures image data.

Document scanning is otherwise known as “document imaging”, and just like it

sounds, when a document is scanned a picture—or “image”—of the document is

taken and converted to a digital file.

Fig.2.4.3.scanner

Scanned images

Images scanned from hardcopy drawings or existing embroidery typically contain

a lot of introduced ‘noise’. While they can be used as input to automatic digitizing,

once again, best results are achieved with relatively clean images consisting of

solid color blocks. Typically, logos and simple drawings scanned from business

cards, letterheads, books, magazines, cards fall into this category

Scanning artwork If you have existing artwork, you can scan it with a

TWAIN-compatible scanner using the BERNINA Embroidery Software scanning

function. It is important to scan your artwork properly if you intend to use one of

the automatic digitizing techniques; the scanned image quality will affect the

quality of the final embroidered design.
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2.4.4.Paper, pens

Paper and pens used for creating new design concept on paper bofore create

digital embroidery design. Practice different design as we want and can convert to

software by scanning methods.

2.4.5.Templates

Working with design templates

Templates are special files used to store default settings. Use templates when

digitizing frequently-used design types so that you do not have to set the current

properties every time. For example, a template may include standard objects and

sample lettering. It may simply have preferred stitch settings, lettering font and

size, and colors set as current properties. Or it may have special density, pull

To create a design template

1 Start a new design or open an existing one.

2 Adjust the object properties as required.

3 Add any objects and lettering to be included in the template. For instance, you

may want to include sample lettering using different baselines. Simply overtype

the sample text when using the template. See Applying lettering baselines for

details.
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Self-Check -4 Written Test

1.Mention computer Hardware devices classification(2pts)

2.What is the difference between scanner and printer?(3pts)

Note: Satisfactory rating – 5points Unsatisfactory - below 5 points

Answer Sheet

Name: _________________________ Date: _______________

Score = ___________

Rating: ____________
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Information Sheet-5 2.5.Developing design specification.

What is a specification?

A specification often refers to a set of documented requirements to be satisfied by

a material, design, product, or service. A specification is often a type of technical

standard. There are different types of technical or engineering specifications, and

the term is used differently in different technical contexts

Specification can be defined as a ‘statement of needs’. It describes what the

customer wants to buy and consequently, what the successful supplier is required

to supply.Specifications can be simple or complex depending on the need. The

success of the procurement outcome often relies on the Specification being a true

and accurate statement of the buyer’s requirements.

Who does it?

The process of Specification writing, conducted in parallel with planning, design

and drawing work, helps create the proper balance between client, statutory,

technical and aesthetic requirements.

A specification details the requirements of the procurement. It is the basis of all

offers and therefore the foundation for a contract. A specification becomes an

essential contract management document which is used to ensure that the

chosen supplier provides what is specified. It must therefore be clear and

accurately define what is expected from a supplier regarding the outputs or the

functional and performance requirements.

What makes a good specification?

A well-structured specification should:

 foster supplier interest

 better engage with the market

 facilitate a competitive environment
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 encourage innovation

 apply a high standard in the delivery of requirements

 be clear and simple and avoid onerous or unnecessary requirements

Before preparing a specification

Before preparing a specification, procurement practitioners should have a clear

understanding of:

 customer, user and stakeholder requirements

 market information

 the risks impacting the procurement

 the evaluation criteria to be applied and the relative importance of each

criteria

 any government policy, international standards, Australian standards and

supplier charters or codes of conduct, which are relevant to the procurement

 innovation and social procurement opportunities

How to write a specification?

Developing specifications should involve close and continuous liaison with

stakeholders (specification writer, technical experts and specialists) and users of

the goods and/or services.

For more complex procurement, a staged approach to developing and refining the

specifications should be considered. This may involve developing an Expression

of Interest (EOI) specifying the requirements at a high level. As the process

moves towards the short-listing and/or limited market approach phase, the

specifications must become more detailed.

Organisations should consider standardising the format and applying uniformity to

specifications, as far as possible. This can help to reduce the cost of the market

engagement process.



Federal TVET Agency
Author/Copyright

TVET program title-Advanced Apparel Production
Level III

Version -1

December,2020
Page 68 of 155

Preparing specifications

By applying this guide, specifications will be more consistent in both content and

format and will save considerable time in preparing an approach to market.

Numbering of each requirement is recommended to allow for ease in referencing

during the market engagement process and for contract management purposes.

The amount of detail in the specifications should reflect the complexity of the

requirement and the nature of the procurement.

Things To Keep In Mind

High quality embroidery comes from files designed for thread. Here’s what to
avoid and keep in mind when creating a design to be embroidered.

Small Details

Embroidery can’t quite produce the fine details that screen printing or dye
sublimation can due to the decorative thread being a less versatile, less precise
medium. Keep this in mind when designing and avoid aspects like thin lines,
narrow spacing and small text.

Fine, light colored lines might not turn out as expected. Fine lines are created with
a series of thin stitches, and the negative space between stitches can make thin
lines look more like dotted lines. Darken up any fine lines and details to ensure
they show up in the finished product.

Apparel

The apparel you choose can affect embroidery in a few different ways. Hats have

limited space to embroider, so it’s important to check the specs of the front of the

hat so your design is the appropriate size. Material is also important to keep in

mind. For example, embroidery will look a lot different on a beanie than it will a

work shirt. The material of a beanie is fluffier, so finer details will be lost easier

than they would be on the more rigid material of something like a work shirt.

Color Matching
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We offer around a 100 different color threads and can order additional colors if

your project calls for it. We also offer Pantone matching, but bouncing light can

cause the thread to look lighter or darker in certain areas and at certain angles.

Good Embroidery Files

Now that you know what to avoid, aim for these standards when you’re designing
for thread:

 Bold lines
 Avoid fine details
 Large elements
 Correct size for garment

The right stitch for your design

Our digitizers decide on the types of stitches that will be the best for each design.
Make sure to follow the guidelines because ultimately the type of stitch used will
depend on your graphic. If you have any preferences for stitches, include them in
the embroidery notes section.
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Self-Check -5 Written Test

Answer the following question in details

1.What is specification(3pts)

________________________________________________________________

_____________________________________________

Note: Satisfactory rating – 3points Unsatisfactory - below 3 points

Answer Sheet

Name: _________________________ Date: _______________

Score = ___________

Rating: ____________
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Information Sheet-6 2.6.Performing routine minor maintenance.

2.6.1.Checking and replacement of needles, attachments and/or parts

Maintenance of Embroidery machines �

Handle materials, machinery, equipment and tools safely and correctly � Use

correct lifting and handling procedures �

Use materials to minimize waste �

Maintain a clean and hazard free working area �

Maintain tools and equipment �

Carry out running maintenance within agreed schedules �

Carry out maintenance and/or cleaning within one’s responsibility �

Report unsafe equipment and other dangerous occurrences �

Ensure that the correct machine guards are in place �

Use cleaning equipment and methods appropriate for the work to be carried out.

Dispose of waste safely in the designated location �

Store cleaning equipment safely after use

2.6.2.Oiling of machine parts

Lubrication can be defined as the application of oily or greasy substances, also

called ‘lubricants’, in order to reduce friction and allow moving machine parts to

slide smoothly past each other.

Lubricants form a film between the metal surfaces of machine parts to avoid

metal-to-metal contact and to keep the machine running efficiently.
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Maintenance (Oiling the machine)

 Turn off the embroidery machine.

 Open the hook cover, and remove the bobbin case.

 Rotate the handwheel (about 50 degrees) to move the race of the hook to a

position where it can easily be oiled. ...

 Put a drop of oil onto the hook. ...

 After oiling, insert the bobbin case into the hook, and then close the hook

cover.

The main functions of a lubricant are:

 Reducing friction by creating a film between two surfaces

 Preventing machine wear

 Corrosion protection

 Cooling by dissipating heat from surfaces

 Sealing

 Cleaning by transporting contaminating particles to filters
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Self-Check -6 Written Test

Explain the following

1.what is lubrication?(2)

2.Benefits of lubrication(3)

Note: Satisfactory rating – 3points Unsatisfactory - below 3 points

Answer Sheet

Name: _________________________ Date: _______________

Score = ___________

Rating: ____________
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Information Sheet-7 2.7.Organizing, protecting and storing designs

How to Digitize Machine Embroidery Designs

Saving

When you save a Design Page it will ask you to choose which Stitch File type you

want to use. For example a Baby Lock / Brother embroidery machine owner will

choose .PES as the stitch file type. In addition, the program will also silently save

a working file (.BE) thus saving you the extra step of saving it separately. As

mentioned earlier, the working file allows you to edit your designs including text.If

you want to save individual files (not both stitch and working) you have all the

options on the File menu.

Embroidery Library/store

Embroidery Library is a design management system in Software. You can view

the designs that are built into the software, that you have created within the

software, or those that you have downloaded and saved on your computer. You

can view designs that are on a USB stick, on a CD/DVD, or on an external hard

drive. You can quickly organize, rename, sort, delete, zip designs, or convert

designs to a different formats. You can also send designs to the machine for

stitching from the Embroidery Library. In addition, you can search for designs with

multiple search options; such as, design name, category, number of stitches, or

number of colors.

Where do I store my embroidery files?

When you order embroidery designs online or on CD,USB flash you have the

option of choosing where to save them on your computer. While you can

theoretically save them anywhere, here are some helpful guidelines for choosing

a saving location.
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Can you find this location again?

We suggest saving designs in a sub-folder of the Documents folder.

How do you want to find this design again?

If you are just starting out, we recommend just putting all of your designs in the

same folder and using a design viewing software to identify them.

Do you keep your designs organized by theme, order number, or size? Theme is

one of the most popular ways to organize designs. If you have a large number of

designs, consider creating sub-folders within your Embroidery Designs folder for

keeping them.

Electronic Organization

Storing and organizing embroidery design files on the computer is easy and

requires the least space. Keeping all design files in one file makes it easier to

create backups and find designs as needed.

 Begin the organizing process by placing all of your design files in one folder;

label the folder “Embroidery Designs.”

 Within the folder, create category folders. Label them using the same

naming conventions used to create the binder. Within each category folder,

create individual folders for each design or design collection, labeled with

design name and number .

 Keep the design file original names in case you need to contact the

company regarding a specific design later. Create a naming rule that allows

you to add descriptive terms to the design file name.

 Save zipped files as original backups only if you plan to edit the designs

using embroidery software. Keep the zipped files in the same folder as the

design or design collection.

 To view the designs saved on your computer while browsing, seek out

design cataloging software or embroidery editing or digitizing software with
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cataloging features. These software programs convert designs to JPEGs to

view them as images. The ability to view your collection on the computer will

come in handy as you search for a design for your next

Storage Solutions

 Always have a second form of storage available in case your computer

crashes or the discs/USB drives fail.

 To create a backup of a CD or USB stick, copy the design files and any

other important files, such as .pdf documents containing sewing information, to

a file folder on your computer.

 To backup design files on the computer, copy the embroidery designs

folder onto a removable hard drive. Removable hard drives are

USB-connected hard drives with anywhere from 50 gigabytes to a terabyte of

storage. Removable hard drives are more reliable for storage than optical

media (CDs or DVDs) because they’re less likely to fail.

 Alternatively, copy the embroidery designs folder onto a cloud-based

storage system. Cloud-based storage is internet-based storage. Many

services, such as DropBox, SugarSync and Google Drive, allow you to store

files online for free or a small annual fee. Storing files online provides extra

protection as these systems regularly backup and protect your data. This

method of backup also allows you to access your files from any computer with

Internet access.
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Self-Check -7 Written Test

Explain the following

1.Keeping all design files in one file is better,why?(2pts)

________________________________________________________________

________________________

2.List and explain Storage Solutions for our desing for protecting from

damage(pts)

________________________________________________________________

________________________________________________________________

____________________

Note: Satisfactory rating – 5points Unsatisfactory - below 5points

Answer Sheet

Name: _________________________ Date: _______________

Score = ___________

Rating: ____________
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OPERATION TITLE:Importing design into software programs.

PURPOSE: enable to import design into software program

EQUIPMENT, TOOLS AND MATERIALS: -computer,embroiidery software

CONDITIONS OR SITUTATIONS FOR THE OPERATION: - given necessary

tools & equipment’s. You are required to perform the following within 20

minutes

PROCEDURE:-

Step1.Importing image data into Layout & Editing

Step2.Automatically converting the image to an embroidery pattern

Step3.Displaying a preview of the embroidery

Step4.Saving the embroidery design

Step5.Transferring the design to an original card

Operation Sheet 1 Importing design into software programs.
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LAP Test 1
Practical Demonstration

Name: ___________________________ Date: ______________________

Time started: ________________ Time finished: _______________

Instruction:

Importing given design into software programs

PROCEDURE:-

Task1.Importing image data into Layout & Editing

Task2.Automatically converting the image to an embroidery pattern

Task3.Displaying a preview of the embroidery

task4.Saving the embroidery design

task5.Transferring the design to an original card
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LG #29 LO #3- Edit design

Instruction sheet

This learning guide is developed to provide you the necessary information regarding the

following content coverage and topics:

 Selecting suitable designs or images

 Importing design into software programs.

 Editing design.

 Determining production specifications.

 Protecting ,Organizing and storing Designs

This guide will also assist you to attain the learning outcome stated in the cover page.

Specifically, upon completion of this Learning Guide, you will be able to:

 Select suitable designs or images

 Import design into software programs.

 Edit design.

 Determine production specifications.

 Protect ,Organize and store Designs

Learning Instructions:

Read the specific objectives of this Learning Guide.

1. Follow the instructions described below.

2. Read the information written in the “Information Sheets”. Try to understand what are being

discussed. Ask your trainer for assistance if you have hard time understanding them

3. Accomplish the “Self-checks” which are placed following all information sheets.

4. Ask from your trainer the key to correction (key answers) or you can request your trainer to

correct your work. (You are to get the key answer only after you finished answering the
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Self-checks).

5. If you earned a satisfactory evaluation proceed to “Operation sheets

6. Perform “the Learning activity performance test” which is placed following “Operation

sheets” ,

7. If your performance is satisfactory proceed to the next learning guide,

8. If your performance is unsatisfactory, see your trainer for further instructions or go back to

“Operation sheets”.
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Information Sheet-1 3.1.Selecting suitable designs or images

Digitized embroidery design files can be either purchased or created with

industry-specific embroidery digitizing software. Embroidery file formats broadly

fall into two categories.

 The first, source formats, are specific to the software used to create the design.

For these formats, the digitizer keeps the original file for the purposes of editing.

 The second, machine formats, are specific to a particular brand or model of

embroidery machine, they contain primarily stitch data (offsets) and machine

functions (stitch, trims, jumps, etc.) and are thus not easily scaled or edited

without extensive manual work. However, because these files easy to decode,

they serve as easy exchange formats, with some formats such as Tajima's .dst

and Melco's .exp being so prevalent that they have effectively become industry

standards and are often supported directly by machines built by rival companies,

or through provided software to convert them for the machine.

Many embroidery designs can be downloaded in popular machine formats from

embroidery websites. However, since not all designs are available for every

machine's specific format, some machine embroiderers use conversion programs

to convert from one machine's format file to another, with various degrees of

reliability.

A person who creates a design is known as an embroidery digitizer or puncher. A

digitizer uses software to create an object-based embroidery design, which can be

easily reshaped and edited. These files retain important information such as

object outlines, thread colors, and original artwork used to punch the designs.

When the file is converted to a stitch file, it loses much of this information,

rendering editing difficult or impossible.

Software vendors often advertise auto-punching or auto-digitizing capabilities.

However, if high-quality embroidery is essential, then industry experts highly
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recommend either purchasing solid designs from reputable digitizers or obtaining

training on solid digitization techniques.

Once a design has been digitized, an embroiderer can use software to edit it or

combine it with other designs. Most embroidery programs allow the user to rotate,

scale, move, stretch, distort, split, crop, or duplicate the design in an endless

pattern. Most software allows the user to add text quickly and easily. Often the

colors of the design can be changed, made monochrome, or re-sorted. More

sophisticated packages allow the user to edit, add, or remove individual stitches.

Some embroidery machines have rudimentary built-in design editing features.
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Self-Check -4 Written Test

1.Mention basic Embroidery file formats categories(2pts)

2.What is digitizer(1pts)

Note: Satisfactory rating – 3points Unsatisfactory - below 3 points

Answer Sheet

Name: _________________________ Date: _______________

Score = ___________

Rating: ____________
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Information Sheet-2 3.2.Importing design into software programs

Converting objects to a stitch pattern

objects drawn with the tools in Layout & Editing can be converted into a stitch

pattern, allowing you to make detailed changes by modifying the position of

individual stitches.

1.Select the object that you want to convert.

2.Click Sew, then Convert to Stitches.The selected object is converted to stitch

pattern

→The dotted line around the converted pattern indicates that it is a stitch pattern.

Each stitch of the converted pattern can be edited with the Edit Point too

Editing stitch points of stitch pattern
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3.Click the object that you want to edit.→The stitch points in the stitch pattern

appear as small empty squares

4.To select a single stitch point, click an empty square.

→The selected stitch point appears as a small black square

Adding Text Entering Text

Sew a ready-made design For many embroiderers, it is enough to take an existing

design and stitch it out. This is certainly where most will start. Once you have

found a design you like, you will want to preview it to see how it will sew out. A

number of steps are involved. We outline the main ones here with reference to the

manual.

Modify an entire design

Once you are used to the steps involved in sewing out designs – either clipart or

ones you have purchased – you will soon want to make global design

modifications such as resizing, or changing thread colors and fabric types. These

are all relatively simple operations.
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To modify an entire design

1 Open the design you want to use. See Opening designs for details.

2 Check design dimensions, and resize as required. See Scaling objects for

details. For example, if you are stitching a left chest design, maximum size will be

approximately 4.25" or 108 mm square.

3 Adjust design thread colors as desired. See Changing thread colors for details.

4 Check the fabric type and change as necessary. See also Changing fabrics.

5 Select a hoop of the required size. See Selecting hoops for details.

6 Visualize the design on a garment or article. See Visualizing finished articles for

details.
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7 Print a worksheet and send the design to machine. See Printing designs and

Stitching out designs in the Reference Manual for details.

How to Digitize Your Logo for Embroidery

You may think that the machine embroidery process is as simple as uploading

your logo to a computer and letting the embroidery machines go to work. However,

the logo digitization process is actually much more complex than that.

What is Logo Digitization?

Embroidery machines are not able to read the same types of files as your

computer can, so you have to digitize your logo in a way that the machines can

understand before they can do their job. From a digitizer's perspective, that

usually means taking a JPG or PNG file of a customer’s company logo or artwork

and converting into an embroidery file. The embroidery file type is determined by

the type of embroidery machine you will be using.

Embroidery File Types by Machine

.dst:embroidery file format for Tajima commercial embroidery machines

.exp:embroidery file format for Melco commercial embroidery machines

.jef:embroidery file format for Janome commercial embroidery machines

.kwk:embroidery file format for Brother commercial embroidery machines
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.dsb:embroidery file format for Barudan commercial embroidery machines

.tap:embroidery file format for Happy commercial embroidery machines

How to Digitize Your Logo

Once you know what kind of embroidery machine, you’re working with you can

move forward with converting the artwork or logo into the proper file type. To do

this you’ll need to have digitizing software installed on your computer. Once

you’ve chosen your embroidery software follow the steps below.

Step 1: Upload Your Logo to the Digitizing Software

In this first step you’ll simply insert your logo or design file (JPG, PNG, etc.) into

the program and crop out any unnecessary blank space around the image you’d

like to be embroidered.

Step 2: Set Embroidery Design Size

Input your desired dimensions for your embroidered logo or design. This will be

the exact size that your image will appear on your product, so make sure to

carefully measure the available space for embroidery on the product first! Once

you have it just right make sure to lock the picture before moving on to the next

step.

Step 3: Choose Your Stitch Type

There are a variety of different stitch types that are used to accomplish different

looks, textures, and more. Each stitch type has a maximum stitch length that must

be taken into consideration.

Step 4: Set Stitch Direction

Setting the stitch direction is essentially creating a road map for your embroidery

machines to follow. In this step you’ll tell provide the machines with step by step
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instructions for each stitch. Different stitch patterns can be used to achieve the

appearance of different contours, textures, and shades. Skipping this step will

result in too many trims, jumps, and an unsightly machine pattern. Creating an

efficient stitch direction will also save you time and thread too!

Step 5: Set Your Embroidery Thread Colors

Select your embroidery thread colors from the color bar. Make sure to match the

embroidery thread colors to your corporate logo Pantone colors.

However embroidered graphics are sewn with thread and have to be simplified so

they appear clear when stitched.. so how do you convert your graphic or image

file into something that will look great when finished?

Automatically Converting an Image to an Embroidery Design

In this section, we are going to use the Auto Punch function to automatically

create an embroidery pattern from an image. This procedure will go through each

step of the basic operation.

Fig.2.1.Converting an Image to an Embroidery Design

Step1.Importing image data into Layout & Editing

Step2.Automatically converting the image to an embroidery pattern

Step3.Displaying a preview of the embroidery

Step4.Saving the embroidery design
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Step5.Transferring the design to an original card

Understanding Windows and Using Tools

Understanding Windows and Using ToolsLayout & Editing WindowThe default

value for the design page size in this example is 100 ×100 mm.

Fig.2.2.Windows and Using Tools

1 Title bar 2 Menu bar Provides access to the functions.

3 Toolbar Provides shortcuts for the menu commands.

4 Sewing Attributes barSets the sewing attributes (color and sew type) of lines

and regions in the pattern.

5 Tool Box Used to create, select and edit patterns.

6 Status barProvides helpful information.

7 Reference Window Displays all patterns in the work area, giving you an

overview while you work on a detailed area.

8 Design Page The actual part of the work area that can be saved and sewn.

9 Work area
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10 Minimize button

11 Maximize button

12 Close button

List of Tool Box Buttons

File menu

The File menu contains commands for handling file input/output, such as opening,

saving and printing.
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Edit menu

The Edit menu contains commands for performing simple actions on selected

patterns, such as cutting and pasting.
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List of Tool Box Buttons

Step 1 Importing image data into Layout & Editing
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First, we need to import the image that will be converted into an embroidery

pattern.

 Start up Layout & Editing.

Fig2.3.A Open software

Click start, then select All Programs, then PE-DESIGN Ver7, then Layout &

Editing.

 Import the image.

Click Image, then Input, then from File.
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Double-click the ClipArt folder to open it.

Select the sample file

→ The image appears in the work area

then click Open/ double-click the file’s icon.
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 Adjust the image size and position.

Drag the handle to adjust the selected image to the desired size

Move the pointer over the selected image, and then drag the image to the desired

position.

Step 2.Automatically converting the image to an embroidery pattern

Next, the image will automatically be converted to an embroidery pattern.

 Select the conversion method.
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Click Image, then Image to Stitch Wizard

Select Auto Punch, and then click Next.

 Convert the image to an embroidery pattern.

Check the Result View of the conversion, and then click Finish.
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→ The generated embroidery pattern is displayed.

Step 3 Displaying a preview of the embroidery

Preview the finished embroidery.
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Step 4 Saving the embroidery design

Once the embroidery design is finished, you may want to save it in order to

retrieve it later.
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Step 5 Transferring the design to an original card

By writing a design to a media that can be used in your sewing machine and

transferring it to your sewing machine, you can actually sew the design. For this

example, we will transfer the design to an original card.

 Insert an original card into the USB card writer module.

 Transfer the embroidery design.

 Quit Layout & Editing.

Create a simple lettering design

Once you are used to sewing out designs and resizing, changing colors and fabric

types, you will definitely want to create your own lettering designs. While it takes

practice to obtain a good quality lettering stitchout, it is as simple as typing letters

on-screen to create attractive lettering in BERNINA Embroidery Software.
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To create a simple lettering design

Adding text

The next object to add to our embroidery pattern is tex

 To change the font, click in the Font selector on the Sewing Attributes bar, and

then select the desired font. For this example, since we will be using the

default font 01, you do not need to change the font setting.

 To change the text size, click in the Text Size selector on the Sewing

Attributes bar, and then select the desired size for the text. For this example,

we will keep the default size of 10.0 mm
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 To change the text color, click the Text body color button ( ) on the

Sewing Attributes bar, click the desired color in the Region Thread Color

dialog box that appeared, and then click Close. For this example, since we will

be using the default color BLACK, you do not need to change the text color

setting.

 To change the text sew type, click in the Text body sew type selector, and

then select the desired sew type for the text. For this example, we will use the

default sew type Satin stitch.

 To enter the text, click in the Design Page. Since we can move the text after

creating it, any place in the Design Page can be clicked.

→ The Edit Text Letters dialog box appears.
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 Type your text (“garment”, for this example).

• You can also enter a character by selecting it in the character table, then clicking

Insert, or simply by doubleclicking it. This is particularly useful if you have to enter

accented characters that are not available on your keyboard.

• To quit the operation, click Cancel.

 Click OK. → The Typically you’ll want to add lettering to an existing design.

Add embroidery lettering to designs quickly and easily, either on-screen using

current settings or via ‘object properties’.

Add embroidery lettering to designs quickly and easily, either on-screen using

current settings or via object properties. Place lettering on a straight horizontal or

vertical baseline, curve it around a circle or arc, or digitize your own baselines.

You can apply formatting to lettering objects in the same way as a word processor,

including italics, bolding, and right/left justification. Letter, word and line spacings

can be determined before or after creating lettering objects and placing them in

your design. See also Embroidery Fonts. This section describes how to add

lettering to embroidery designs. It also covers applying lettering baselines,

formatting lettering and adjusting letter spacing.
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Fig.lettering to design

Adding lettering to embroidery designs You can add lettering to a design by typing

it directly on-screen. Adjust object properties to specify letter formatting before or

after adding it to a design.

Creating lettering on-screen

If it is not essential to fit letters precisely to a certain area, you can type them

directly on-screen. You can also modify lettering objects directly on-screen to

achieve various artistic effects. Appearance and layout depend on current settings.

You can change them at any time.

To create lettering on-screen

 Click the Lettering icon.

 Select a color from the Color Palette.

 Click where you want to start typing.

 Type the letters you want to embroider. Thick-thin calligraphy effect Use

Digitize > Lettering to create embr

 Press Enter to complete. Stitches are generated immediately.
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Self-Check -2 Written Test

1.list steps How to Digitize embroidery Logo

2.List different Embroidery File Types with Machine tpyes

Note: Satisfactory rating – 3points Unsatisfactory - below 3 points

Answer Sheet

Name: _________________________ Date: _______________

Score = ___________

Rating: ____________
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Information Sheet-3 3.3.Editing design.

Custom Embroidery Digitizing Design Manipulation

During custom embroidery digitizing, an embroidery digitizer often comes across

designs that are not originally designed for embroidery. In most cases, designs

are originally prepared for another purpose which is later used for custom

embroidery. In such cases, these designs have to be manipulated in order to be

used as machine embroidery designs.

.Manipulation of height

To size only in height or width, click to unlock the lock icon. In the tool pane,

choose millimeters or inches. Use the lock icon to size proportionally, and enter

the height or width you would like. To change height or width only, unlock the lock

icon before entering height or width measurements.

Three ways to resize:

 Drag nodes

When your design is selected (clicked on), there are 8 black nodes around it.

Click a corner node and drag to proportionally size the design.Click a middle

node on top or bottom to change height only.Click a middle node on right or

left to change width only.
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 Use percentage

In the tool pane, use the percentage inputs to choose the size.

Use the lock icon to size proportionally.

To size only in height or width, click to unlock the lock icon.

 Use measurements

In the tool pane, choose millimeters or inches.

Use the lock icon to size proportionally, and enter the height or width you

would like.

.Manipulation of scale
You can scale objects directly on-screen or by setting exact dimensions or scale

percentage. As an object is scaled, the stitch count changes to preserve current

stitch spacing.

To scale height and width proportionally, use a corner handle

Scaling numerically

 Select the patterns that you want to resize.

 Click Edit, then Numerical Setting, then Size.

→ The Size dialog box appears

 To change the width and height proportionally, select the Maintain aspect ratio

check box.
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 Select whether the width and height will be set as a percentage (%) or a

dimension (millimeters or inches).

 Type or select the desired width and height.

 To resize the selected pattern while maintaining the original density and fill

pattern, select the Keep density and fill pattern check box.

 Click OK.

Manipulation of skew/slant

The skew field allows you to alter the slant angle of the letter based on the original

digitized letter form. The height of the letter will remain as specified in the height

field, but the angle will change using the degree specified in the slant field.

Skew selected objects by specified amount – positive or negative – in degrees.

To skew objects

Select the design or object/s to skew.

Click a second time.

Rotation handles appear at the corners and skew handles at center-top and

bottom of the object.

Drag skew handles left or right.



Federal TVET Agency
Author/Copyright

TVET program title-Advanced Apparel Production
Level III

Version -1

December,2020
Page 110 of 155

Manipulation of rotation

Mirroring is about the horizontal or vertical axes. Rotation is clockwise or counter

clockwise in 90 degree increments with the pivot point in the center of the

selection.Alternatively, you can enter a specific value for the degree of rotation.

Enter a positive value to rotate counter-clockwise and a negative value to rotate

clockwise

To rotate objects Select the design or object/s to rotate
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Click the object/s a second time.

Rotation handles appear at the corners and an anchor point at the center of the

object.

If required, drag the rotation anchor from the center to a new position.

Click a rotation handle, and drag it clockwise or counter-clockwise. An outline and

cross-hairs display as you rotate.

.Manipulation of width

The design width property allows you to alter the width of the design based on the

original digitized design form. The height of the design will remain as specified in

the height field, but the width will change using the percentage in the width field.

.Manipulation of length

The present size of the image will appear initially in the Width (265 mm for this

example) and Height (265 mm) boxes. Edit these by entering the desired sizes for

the image (in mm).

ResizeUse this toolbar command to open a dialog (shown below) for resizing the

image. This is a useful option if you want to work in Sew Art with an image of

comparable size to the final stitched pattern.
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Manipulation of fonts

Font Selection Some fonts may only have uppercase letters. If you’re using a font

and not seeing the desired characters, clicking the ‘?’ button to the right of the

Font box; it will display all characters available in the select-ed font along with size

recommendations.

Manipulation of fill

closed objects. Patterns are repeated in parallel rows to fill a shape. You can

design the pattern layout on-screen or by adjusting object properties.

Manipulation of baseline

Sometimes individual letters require adjustments for their baseline. In the view,

the pictures of each letter are shown, with a black line representing the baseline.

You can click on a letter to select it, and once selected, drag the letter up or down

as necessary to place it relative to the baseline as you like.Some things like

apostrophes always need adjustment, naturally, but letters with descenders like

“g” or “y” will usually need adjustment also.
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Manipulation of envelopes

Envelope The perspective line type can create the illusion of depth. By

manipulating the wireframe lines, the lettering adheres to the upper and lower

lines without changing the width of the letters.When envelope line type is first

selected, a wireframe line will appear on the top of the lettering element as well as

along the bottom. If you hover over one of these lines or the points at either end of

them, your cursor will change and you can alter the line. For more information on

wireframe editing the lines, see the wireframe editing section.
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The envelope (containing top and bottom outlines) of the lettering (single or

multi-line) can be indi-vidually customized. The Envelope Type box and Envelope

Slider control the envelope. There is an Envelope Slider control for the envelope

top and there is an envelope slider control for the envelope bottom.

Enveloping can produce a variety of creative designs, especially when you begin

breaking up the words into segments and enveloping each one separately.

Manipulation of borders

Use the Create Border options to create a new embroidery with a border in the

shape you have drawn and placed.

Select a margin width and whether to use rounded corners, then select a border

type from motif line, satin border, running stitch and triple stitch. Click Options to

set the properties for each stitch type.

Manipulation of spacing
Adjusting stitch spacing You may need to change stitch density in order to stitch

on a different fabric or with a different thread. Or you may want to do a test design

and reduce the overall stitch count. The software lets you change the density of

most stitch types across the whole or selected parts of a design.

Spacing Sometimes text is too crowded or too loosely spaced.

Line spacing is defined as the distance from the bottom of one line to the bottom

of the next. A letter height of 1.0 inch with a line spacing of 1.0 inch makes the

letters from each line touch. To have space between the letters, you must have a
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line spacing greater than the letter height. If it is less than or equal to the letter

height, the letters will touch or overlap.

Adjusting stitch spacing

You may need to change stitch density in order to stitch on a different fabric or

with a different thread. Or you may want to do a test design and reduce the overall

stitch count. The software lets you change the density of most stitch types across

the whole or selected parts of a design.

To adjust stitch spacing

1 Select the design or objects you want to adjust.

2 Select Edit > Adjust Stitch Spacing.

3 Click OK.

Manipulation of needle penetration/stitch length
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The stitch length field determines the distance between the majority of the needle

penetrations or length of the stitches within the fill. Along the edges, the stitches

may fall shorter than this length to preserve the pattern of the fill.

Manipulation of stitch size and type
When doing any sizing work, you need to be aware of current dimensions.

Typically, you will be scaling an entire design for different applications.

Manipulation of color

Adjust design colors as preferred. The simplest technique is to click objects in the

design and select a color from the Design Colors toolbar. Many other techniques

exist such as using the Sequence docker to select objects or entire color blocks.

You can also select colors from different thread charts.

When you digitize, you select thread colors for each object you create from the

Color Palette in the design window. The palette contains a selection of thread

colors tailored to each design. This color scheme represents the actual threads in

which the design will be stitched.

Coloring Letters

Coloring Letters works a bit differently. To color individual letters, click on the

center of the letter to select it. Then, as before, click the color swatch to select a

new thread color.
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Editing the color

 Select the frame for the pattern whose color you want to change, and then

click .

→ The Thread Color dialog box appears.

 Select the desired color, and then click OK.

→ The object appears in the new color in the Sewing Order/Color dialog box and

in the Design Page.

 Click OK.

→ The pattern is displayed with the new color.

Changes to content
After digitizing a design, you can modify it as a whole, edit individual objects or

even individual stitches.
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Changes to style
This section describes how to combine objects and designs by copying and

pasting, duplicating, and inserting whole designs and design elements. It also

covers grouping and splitting objects, as well as sequencing objects using various

techniques including Color Film. It also discusses auto-sequencing entire designs.

Changing thread colors New objects are digitized using the selected color in the

color chart. You can change the color before or after digitizing.

Reshape objects

Reshaping operations may be called on for anything from minor modifications to

object shapes to reshaping letters for special effects. In most cases, if it is

selectable, it can be reshaped. See Reshape objects.

Add multiple borders Add up to four borders to the selected monogram. Use the

Offset field to adjust margins between multiple borders. When you set multiple
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borders, the offset you specify is calculated from the previous border. If you

change the border offset, all borders are updated.

Changes to finish

Changing backgrounds and display settings

The embroidery objects comprising a design form a ‘stitching sequence’. Before

digitizing, it is good practice to analyze and plan design shapes and stitching

sequence in advance. Shapes need to be clearly defined to make them easy to

embroider. The best shapes have relatively constant width, with smooth edges, no

sharp turns and no small, protruding details.

Image clean up

In practice, cleaning up scanned images may involve any one or a combination of

the following techniques:

 reducing the number of colors

 adding or emphasizing outlines

 eliminating unnecessary detail

 cropping sections
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 eliminating backgrounds

Color reduction

Sometimes an image looks clean but extra colors have been introduced during

scanning or in a graphics package. Color reduction means reducing the actual

number of image colors in order to eliminate unnecessary detail and reduce each

block to a single color.
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Self-Check -3 Written Test

Explain the following as required

1.What Line spacing(2pts)

______________________________________________

2.Whya we Adjust stitch

spacing(2pts______________________________________________________

3.List down Image clean up techniques during create design(3pt

________________________________________________________________

______________________

4.Write the steps to skew objects (3pts)

-________________________________________________________________

_________________________________________

note: Satisfactory rating – 10points Unsatisfactory - below 10 points

Answer Sheet

Name: _________________________ Date: _______________

Score = ___________

Rating: ____________
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Information Sheet-4 3.4.Determining production specifications.

Embroidery size limits

height and Width: Max - 18”, Min - 1” (+/-1mm)Visual

COLOR

Embroidery: The design cannot have more than 15 different colors of thread.

PRODUCTION TIME

Samples time 2 days plus shipping.Production time 5 days plus shipping

(additional day per 500 pieces).

MINIMUM SIZE TEXTS

For flat embroidered text cannot have a height smaller than 4mm and column

width of 1mm.

Art Specifications

The first step in embroidered custom decorated apparel is having an acceptable

and accurate art file to work from.

All digital files are redrawn as virtual stitches to communicate the design to the

embroidery machine. The process for redrawing a design or logo as stitches is

called digitizing. The cleanest files produce the perfect embroidery.

MAIN POINTS OF EMBROIDERY FILE REVIEW

Letter Size – Letters can be no smaller than .25″ or they will not embroider well.
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Detail – Super fine detail will likely be compromised. Most embroidered logos are

small by nature, thread is a fixed width and the fabric adds an element of

compromise.

Gradients – Complicated gradients can sew very well. Keep in mind, however,

that stitches do not blend, so the gradient will be less smooth in appearance than

what you see on your computer screen.

PREFERRED FORMAT

Vector files (ai, eps, pdf) with fonts converted to outlines. This format produces the

highest quality embroidery.

ACCEPTABLE FORMAT

Raster files (jpg, tif, gif, png, eps) at a minimum of 150dpi at the final image size.

These images, designs, or logos are composed of pixels rather than paths. When

zoomed in it is more difficult to see detail and where shapes begin and end. For

this reason a digitizer must do some creative estimating. Your end embroidery

may not be as exact as you would like it to be.
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Self-Check -4 Written Test

Answer the following

1.List what are should be included during embroidery design specification

development

note: Satisfactory rating – 2points Unsatisfactory - below 2 points

Answer Sheet

Name: _________________________ Date: _______________

Score = ___________

Rating: ____________
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Information Sheet-5 3.5.Protecting ,Organizing and storing Designs

Setting up your file folders to organize your embroidery designs

Create meaningful names

after you download a design, it’s a good idea to change the file name to something

more meaningful to you that will help you identify it in the future.

Set up files and folders

If you just download embroidery designs, rename them and store them in one

folder, you will end up with a lot of files in a single folder, so you probably set up

some subdirectories, sub subdirectories, and so on.

There are generally two different schools of thought regarding how to set up the

folder structure for machine embroidery designs. Some people organize files by

designer, and others do so by type or theme. There are benefits of each system.

If you organize your embroidery designs initially in folders by designer, it can help

you remember where you got the design. This is helpful if you want to go back and

buy additional designs in a similar style.

Keep the image of the design

Most designers include a picture of the design stitched out with the embroidery

files. If you keep this picture in the folder of the extracted zip file, your operating

system will naturally create a preview for you. If the designer doesn’t include a

JPG image of the design stitched out, you can simply save the image from the

website and store it in the extracted folder.

Embroidery Library/store
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Embroidery Library is a design management system in Software. You can view

the designs that are built into the software, that you have created within the

software, or those that you have downloaded and saved on your computer. You

can view designs that are on a USB stick, on a CD/DVD, or on an external hard

drive. You can quickly organize, rename, sort, delete, zip designs, or convert

designs to a different formats. You can also send designs to the machine for

stitching from the Embroidery Library. In addition, you can search for designs with

multiple search options; such as, design name, category, number of stitches, or

number of colors.

Where do I store my embroidery files?

When you order embroidery designs online or on CD,USB flash you have the

option of choosing where to save them on your computer. While you can

theoretically save them anywhere, here are some helpful guidelines for choosing

a saving location.

Can you find this location again?

We suggest saving designs in a sub-folder of the Documents folder.

How do you want to find this design again?

If you are just starting out, we recommend just putting all of your designs in the

same folder and using a design viewing software to identify them.

Do you keep your designs organized by theme, order number, or size? Theme is

one of the most popular ways to organize designs. If you have a large number of

designs, consider creating sub-folders within your Embroidery Designs folder for

keeping them.

Electronic Organization

Storing and organizing embroidery design files on the computer is easy and
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requires the least space. Keeping all design files in one file makes it easier to

create backups and find designs as needed.

 Begin the organizing process by placing all of your design files in one folder;

label the folder “Embroidery Designs.”

 Within the folder, create category folders. Label them using the same

naming conventions used to create the binder. Within each category folder,

create individual folders for each design or design collection, labeled with

design name and number .

 Keep the design file original names in case you need to contact the

company regarding a specific design later. Create a naming rule that allows

you to add descriptive terms to the design file name.

 Save zipped files as original backups only if you plan to edit the designs

using embroidery software. Keep the zipped files in the same folder as the

design or design collection.

 To view the designs saved on your computer while browsing, seek out

design cataloging software or embroidery editing or digitizing software with

cataloging features. These software programs convert designs to JPEGs to

view them as images. The ability to view your collection on the computer will

come in handy as you search for a design for your next

Storage Solutions

 Always have a second form of storage available in case your computer

crashes or the discs/USB drives fail.

 To create a backup of a CD or USB stick, copy the design files and any

other important files, such as .pdf documents containing sewing information, to

a file folder on your computer.

 To backup design files on the computer, copy the embroidery designs

folder onto a removable hard drive. Removable hard drives are

USB-connected hard drives with anywhere from 50 gigabytes to a terabyte of
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storage. Removable hard drives are more reliable for storage than optical

media (CDs or DVDs) because they’re less likely to fail.

 Alternatively, copy the embroidery designs folder onto a cloud-based

storage system. Cloud-based storage is internet-based storage. Many

services, such as DropBox, SugarSync and Google Drive, allow you to store

files online for free or a small annual fee. Storing files online provides extra

protection as these systems regularly backup and protect your data. This

method of backup also allows you to access your files from any computer with

Internet access.
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Self-Check -5 Written Test

Explain the following questions

1.Where do we store our embroidery files?(3pts)

2.Designs can be organized and keep by ____________(2)

note: Satisfactory rating – 5points Unsatisfactory - below 5 points

Answer Sheet

Name: _________________________ Date: _______________

Score = ___________

Rating: ____________
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OPERATION TITLE: Creating and editing embroidery design

PURPOSE: enable to create and edit design before import to embroidery file

EQUIPMENT, TOOLS AND MATERIALS: -computer,embroiidery software

CONDITIONS OR SITUTATIONS FOR THE OPERATION: - given necessary

tools & equipment’s.

You are required to perform the following within 20 minutes

PROCEDURE:-

Step1 -Set up work station

Step 2 -open computer and embroidery software

Step 3-create and edit letter by using embroidery software

Step 4- convert design embriodery file

Basic Lettering Exercise.

Use the lettering tools to create a 2-line text logo in typical style with 2 different

font styles.

TASK 1: Set up work station

TASK 2: -create and edit letter by using embroidery software

TASK 3: convert design embriodery file

Operation Sheet 1 Creating and editing embroidery design
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LAP Test 1
Practical Demonstration

Name: ___________________________ Date: ______________________

Time started: ________________ Time finished: _______________

Instruction:

Creating and editing embroidery design

PROCEDURE:-

TASK 1: Set up work station

TASK 2: -create and edit letter by using embroidery software

TASK 3: convert design embriodery file



Federal TVET Agency
Author/Copyright

TVET program title-Advanced Apparel Production
Level III

Version -1

December,2020
Page 132 of 155

LG #30 LO #4- Present design for feedback

Instruction sheet

This learning guide is developed to provide you the necessary information regarding the

following content coverage and topics:

 Presenting design concept

 Receiving and considering Feedback

 Modifying and improving Design concept.

This guide will also assist you to attain the learning outcome stated in the cover page.

Specifically, upon completion of this Learning Guide, you will be able to:

 Present design concept

 Receive and considering Feedback

 Modify and improve Design concept.

Learning Instructions:
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Read the specific objectives of this Learning Guide.

9. Follow the instructions described below.

10.Read the information written in the “Information Sheets”. Try to understand what are being

discussed. Ask your trainer for assistance if you have hard time understanding them

11. .Accomplish the “Self-checks” which are placed following all information sheets.

12.Ask from your trainer the key to correction (key answers) or you can request your trainer to

correct your work. (You are to get the key answer only after you finished answering the

Self-checks).

13. If you earned a satisfactory evaluation proceed to “Operation sheets

14.Perform “the Learning activity performance test” which is placed following “Operation

sheets” ,

15. If your performance is satisfactory proceed to the next learning guide,

16. If your performance is unsatisfactory, see your trainer for further instructions or go back to

“Operation sheets”.
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Information Sheet-1 4.1.Presenting design concep

4.1.1.How to Present design concept for feedback

Design feedback is an integral part of any successful design project, it gives

clients an opportunity to review and critique a design solution that has been

presented. It is the role of the design contact (the representative that liaises with

the design team) to collate and manage internal communications at their end and

provide the agency with a concise list of feedback.

Below is a step-by-step guide to help you provide any designer with detailed

design feedback that will result in the best outcome for any design project.

6 steps to provide effective design feedback

Step 1 - Start by clarifying the objective

Whether viewing a new design for the first time via email or in person these three

questions will set you in good stead for providing effective feedback.

Does the design meet my brief?

Is the design aligned with our organization’s brand?

Does the design contain all relevant content?

Step 2 - Be clear

As the old adage says... keep it simple! Providing simple and clear feedback will

ensure that the designer will implement feedback accurately, and that means a

faster start to your website/print project!

Step 3 - Be specific

It's not a secret that designers the world over get frustrated with ambiguous

feedback that doesn't really tell us much at all.

Step 4 - Be descriptive

The more context and reasoning, the better! In general, comments like, "I just

don't like it," or, "This sentence isn't true," aren't constructive; they simply don't

provide the detail and necessary guidance to make changes from a design

perspective.
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Step 5 – Be disciplined

Most agencies follow a clear process when working on design projects. Usually

there are several 'rounds' of 'design' with 'design feedback'. Agencies present

designs to clients and give them several days (depending on their individual

project timeline) to review and consolidate their feedback. The agency then

undertakes the first, second and third rounds of revision.

A. First round: Identify major issues and provide feedback to address them.

B. Second round: Confirm that the changes made have resolved the issues

identified in the first round; tweak and respond if they don't.

C. Final round: Approve the design tweaks and move forward.

Step 6 – Listen

You've no doubt realized by now that designers are a finicky bunch, we like things

'just so'. The design team at Butterfly prides themselves on upholding an

exceptionally high-standard of design, and we genuinely want the best outcome

possible for our clients.
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Self-Check -1 Written Test

Give correct answer for the given questins

1.Design feedback is an integral part of any successful design project

A.true B.false

note: Satisfactory rating – 5points Unsatisfactory - below 5 points

Answer Sheet

Name: _________________________ Date: _______________

Score = ___________

Rating: ____________
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Information
Sheet-2

4.2.Receiving and considering feedback line with design
objectives.

4.2.1.How to give and receive feedback effectively

Giving and receiving feedback is not an easy task and poses significant

challenges for both sides. In this article, we will discuss pragmatic feedback

models, how to overcome barriers to an effective feedback and tips for giving

effective feedback, as well as how to receive feedback and make the most out of

it.

4.2.2.Types of feedback

●Informal feedback is the most frequent form. It is provided on a day-to-day basis,

and is given on any aspect of a professional performance and conduct, by any

member of the multidisciplinary team. It is usually in verbal form.

●Formal feedback comes as part of a structured assessment; it can be offered by

any member of the multidisciplinary team, but most frequently by peers or

superiors. It is usually in written form.

●Formative feedback, “for learning”, is about a learner’s progress at a particular

time through a course or during the acquisition of a new skill. It provides

opportunities to gain feedback, reflect and redirect effort (where appropriate)

before completing a final assessment. It gives you the experience of writing or

performing a task without it having a direct impact on your formal progress and

relies on continuous encouragement.

●Summative feedback, “of learning”, measures performance, often against a

standard, and comes with a mark/grade and feedback to explain your mark. It can

be used to rank or judge individuals.

For the purpose of this article, we will focus on formal and informal feedback.

Why is feedback important?

As a general rule, it seems that learners value feedback more when it is given by

someone they respect as a role model. Appropriate feedback contributes
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significantly in developing learners’ competence and confidence at all stages of

their professional careers;

How to give and receive feedback effectively actual and desired performance, and

identify ways to narrow the gap and improve.

Who gives feedback?

In professional life, your patients and anyone working with you as a member of the

multidisciplinary team can give you feedback. Feedback in these cases is meant

to be given reciprocally, i.e. you will also need to give feedback to your peers.

How to Take Design Feedback Strategically

Preparing for Design Feedback

Getting quality design feedback is essential to the collaborative, iterative design

process.

When soliciting design feedback on a particular solution, or trying to cultivate a

meaningful discussion about an element of a design, the presentation sets the

stage. The design review presentation format should be compatible with all the

collaboration platforms and tools being used to share designs. Here are a few tips

to help prepare a presentation that will encourage an audience to give valuable

feedback:

Play to Your Audience

Feedback from a client should be viewed in a different light than that from other

design professionals, colleagues, or a creative director. Clients offer a different

perspective, and it’s important that other stakeholders consider their input with an

open mind. Additionally, it’s very likely they will not be well-versed in how to give

design feedback, so prepare the presentation with that in mind.

Feedback from Clients
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When presenting to a client, try to anticipate their point of view. Typically, a client

will have a vaguely formed idea that they find difficult to express in design terms;

they have entrusted you with realizing their vision and shepherding it through the

many pitfalls and challenges facing any production. Their response will be

informed by many factors, including the product vision and hard reality of their

business goals; they will be weighing not only the strength of the design but how

well it aligns with these other factors. It is critical the presentation shows these

factors have been considered, and comprehensively explains how the design will

achieve the client’s goals.

Feedback from Designers

Fellow designers, developers, and other members of the team will, quite naturally,

have different concerns. Other designers will be considering the success of the

solution and offering critiques to help strengthen it. T

Receiving Feedback

Now that the solution has been presented, it’s time for the crucible! If the concepts

have been presented confidently and clearly, while also anticipating the

audience’s specific needs, it is most likely focused critique and useful suggestions

will be returned. That doesn’t guarantee, however, that everyone will love the

idea—and that’s ok. Remember these few tips while on the receiving end:

Ask: Is This Quality Feedback?

In the same way that some design is better than others, feedback also varies in

quality. Great design feedback will help strengthen and improve the design. Bad

design feedback—if handled improperly—can be a distraction that undermines

everything.
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Self‐Check ‐2 Written Test

Give short answer

1.List and explain Types of feedback(3pts)

2.What is the difference between Great design feedback and Bad design

feedback(2pts)

note: Satisfactory rating – 5points Unsatisfactory - below 5 points

Answer Sheet

Name: _________________________ Date: _______________

Score = ___________

Rating: ____________
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Information Sheet-3 3.1.Modifying and improving design concept

Modify a design Once you are used to the steps involved in sewing out designs –

either clipart or ones you have purchased – you will soon want to make global

design modifications such as resizing, or changing thread colors and fabric types.

These are all relatively simple operations. We outline some of the common ones

here with reference to the User Guide.

To modify an entire design

1 Open the design you want to use.

2 Check design dimensions, and resize as required. See Scaling objects for

details.

3 Adjust design thread colors as desired.

4 Check the fabric type and change as necessary.

5 Select a hoop of the required size.

6 Visualize the design on a garment or article.

7 Print a worksheet and send the design to machine. See Printing designs and

Stitching out designs in the Reference Manual for details

Reshape elements

Reshaping operations may be called on for anything from minor modifications to

object shapes to reshaping letters for special effects.

Sequence your design elements

Design sequence is the order in which objects are created and therefore in which

they are stitched out. You can change the object sequence to improve sewing –

for example, to minimize color changes. Details should be stitched last.
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Editing designs

Once a design has been digitized, an embroiderer can use software to edit it or

combine it with other designs. Most embroidery programs allow the user to rotate,

scale, move, stretch, distort, split, crop, or duplicate the design in an endless

pattern. Most software allows the user to add text quickly and easily. Often the

colors of the design can be changed, made monochrome, or re-sorted. More

sophisticated packages allow the user to edit, add, or remove individual stitches.

Some embroidery machines have rudimentary built-in design editing features.

Modify Embroidery Designs

Many embroiderers have no desire to create embroidery designs. They prefer

using embroidery designs from the wonderful designers that are on the market.

However, they want to make changes to the embroidery, such as changing size,

thread colors, area shape, deleting parts, or even borrowing parts from other

embroidery designs.

In order to modify designs, embroidery software must be object-based - that is, it

must have the ability to break down embroidery designs into embroidery objects.

Embroidery objects, which are pieces or segments of the design, can be isolated

so they can be manipulated, allowing you to change them.
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The types of changes that can be done to embroidery objects using object-based

software are diverse. They can:

 Be resized, changing stitch count and keeping density intact

 Have thread color changed

 Have fill pattern changed

 Be moved

 Be rotated

 Be reshaped

 Have underlay changed

 Have density changed

 Copied

 Pasted

 Have a hole cut out

 Have holes filled in
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Self‐Check ‐3 Written Test

Give short answer

1.what is the importance of change the object sequence during edit design?

2.Embroiders can buy embroidery design from designers and make modification

as they want.

A.true B.false

note: Satisfactory rating – 5points Unsatisfactory - below 5 points

Answer Sheet

Name: _________________________ Date: _______________

Score = ___________

Rating: ____________
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LG #31 LO #5- Clean up

Instruction sheet

This learning guide is developed to provide you the necessary information regarding the

following content coverage and topics:

 OHS practices

 Cleaning and setting up Workbench/station

 Cleaning and storing tools, equipment and materials properly.

This guide will also assist you to attain the learning outcome stated in the cover page.

Specifically, upon completion of this Learning Guide, you will be able to:

 OHS practices

 Clean and set up Workbench/station

 Cleane and store tools, equipment and materials properly.

Learning Instructions:

Read the specific objectives of this Learning Guide.

1 Follow the instructions described below.

2.Read the information written in the “Information Sheets”. Try to understand what are being

discussed. Ask your trainer for assistance if you have hard time understanding them

3.Accomplish the “Self-checks” which are placed following all information sheets.

4.Ask from your trainer the key to correction (key answers) or you can request your trainer to

correct your work. (You are to get the key answer only after you finished answering the

Self-checks).

5.If you earned a satisfactory evaluation proceed to “Operation sheets

6.Perform “the Learning activity performance test” which is placed following “Operation

sheets” ,

7.If your performance is satisfactory proceed to the next learning guide,

8.If your performance is unsatisfactory, see your trainer for further instructions or go back to

“Operation sheets”.
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Information Sheet-1 5.1.clean up

5.1.1. OHS practices

Ergonomic arrangement of workplaces

Ergonomic risk factors are those problems that cause unnecessary physical

fatigue in employees. These risk factors are commonly found in the manual

material handling environment. Three primary factors include stressful postures

while handling materials like bending or twisting, highly repetitive motions such as

frequent reaching and lifting, and forceful exertions like carrying or lifting heavy

loads. Identify all such ergonomic risk factors and minimize them by putting

control measures in place to limit the exposure of employees to all possible risks.

Information Sheet‐2 5.2.Cleaning and setting up Workbench/station

Dry Cleaning

Embroidery may be dry cleaned, however, extreme care should be exercised

when dry cleaning. Special care must be taken when dark shades are dry cleaned.

Avoid use of pre-spotting agents.

Tips for Keeping Your Workbench Clean

A dirty workbench is also a dirty work area. If you combine dirt with clutter, you

end up with a workbench no one appreciates.

 Set Up Multiple Storage Options

A workbench without adequate storage is an invitation to clutter. Without a place
to put each piece, you are likely to just throw your tools on the workbench after
you finish whatever you are working on. A few projects will come and go before
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you realize you cannot find a particular tool you need. And if it is just a simple tool
for a simple job, your frustration level will go up.

The first tip for keeping a clean work bench is as simple as the old adage that says,
‘a place for everything, and everything in its place’. In short, set up adequate
storage options to accommodate all of your tools and accessories.

 Clean Up Immediately after Each Job

When you were growing up, did your parents make you clean up the toys you
were playing with before getting something new out of the closet? If so, your
parents were smart. They were teaching you to clean up when you finish
something so that you don’t leave a mess behind as you move on to something
else. The same strategy works very well for adult workbenches.

 Divide Tools into Groups

As long as you have committed yourself to maintaining a clean workbench, why
not commit to organization as well? Tool organization is made easier by grouping
your tools into specific categories.

 Don’t Let Dust and Dirt Accumulate

All of our tips thus far have been about organization. Now let us shift gears to dirt
and debris. Dirt can be a problem if you allow it to accumulate, regardless of how
organized your tools are. So do not let it accumulate. As soon as you see the first
hint of dirt, debris, sawdust, etc., clean it up.

 Clean and Disinfect Your Bench

Last but not least is the task of cleaning and disinfecting. When should you
disinfect your workbench? That depends on how you use it. you need only clean
the bench when it starts looking dirty.
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Self‐Check ‐2 Written Test

1.list down some Tips for Keeping Your Workbench Clean(3pts)

note: Satisfactory rating – 3points Unsatisfactory - below 3 points

Answer Sheet

Name: _________________________ Date: _______________

Score = ___________

Rating: ____________
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Information Sheet‐3 5.3.Cleane and store tools, equipment and materials properly.

What can you do to maintain the cleanliness of the tools and equipment?

How do you store your tools and equipment after use?

Keeping your tools properly stored, cleaned, and maintained will save you time

and money and make your DIY endeavors that much more rewarding.

To avoid rust whenstoring your tools:

 Keep your toolsin a dry place. ...

 Hang your garden tools. ...

 Storepower tools in their original cases. ...

 Usesilica gel packs or rust collector

Use, care & maintenance of cleaning tools

 Dry clean. Remove visible and gross soils and debris.

 Pre-rinse. Rinse all areas and surfaces until they are visibly free of soil.

 Wash (soap and scrub). ...

 Post-rinse. ...

 Inspect. ...

 Sanitize. ...

 Dry. ...

 Verification.

Image clean up

In practice, cleaning up scanned images may involve any one or a combination of

the following techniques: reducing the number of colors adding or emphasizing

outlines removing noise, dithering or anti-aliasing eliminating unnecessary detail

cropping sections eliminating backgrounds.
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Color reduction Sometimes an image looks clean but extra colors have been

introduced during scanning or in a graphics package. Color reduction means

reducing the actual number of image colors in order to eliminate unnecessary

detail and reduce each block to a single color. Color reduction also cleans the

image, removing noise and anti-aliasing if present. This in turn helps minimize the

number of trims and color changes required in the resulting embroidery design.

Reduce colors in a non-outlined and outlined images using the Bitmap Artwork

Preparation function. Color reduction should only be applied if the loss of detail

does not affect the image shapes. Before color reduction, the colored areas in the

image below include many colors. After reduction, each area is reduced to a

single color. The detail is preserved.

Rules of good embroidery

Keep the following points in mind when looking at embroidery designs, both your

own and others: Stitches are neat, smooth and even Design looks good – shapes,

colors, balance Shapes are filled with correct fill and outline stitches Stitches are

angled to match shapes Shapes are stitched correctly – no unwanted gaps

Details are clearly defined Lettering is clear and easy to read.

The stitchout should also have the following characteristics: The design sews

efficiently on the machine The fabric does not pucker around stitched areas The

design is free of loose ends. Good embroidery quality starts with good design.

You then need a good quality machine to stitch it out. But even that is not enough

if you do not use the correct fabric, threads, backings, tension, and so on. Consult

your machine manual for advice and get as much advice from other embroiderers

as you can.
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Self‐Check ‐3 Written Test

Answer the following question

1.cleaning up scanned images may involve different techniques,list some of

them(2pts)

2.What are Rules of good embroidery (3pts)

note: Satisfactory rating – 5points Unsatisfactory - below 5 points

Answer Sheet

Name: _________________________ Date: _______________

Score = ___________

Rating: ____________
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